# PRINT AUDIT 5 OVERVIEW
Welcome........................................................................................................................................2
Getting Started................................................................................................................................2

# PRINT AUDIT 5 HOW TO GUIDES
How to Set the Cost Per Page For A Printer..................................................................................5
How to Set Declining Balances For Users......................................................................................6
How to Restrict Access to the Administration Tool........................................................................7
How to Require PIN Code Entry Before Printing.........................................................................7
How to Redirect Print Jobs to More Efficient Printers....................................................................8
How to Make Print Audit Track Jobs With No User Interaction....................................................9
How to Import Values and Users From Print Audit 4.................................................................10
How to Enforce Duplex Only Printing.........................................................................................11
How to Charge for Printing Based on Paper Size........................................................................12

# PRINT AUDIT 5 ADMINISTRATION
Welcome............................................................................................................................................13
General...........................................................................................................................................13
Client Settings...............................................................................................................................15
Client Custom Fields...................................................................................................................18
User Profiles................................................................................................................................29
Users ..............................................................................................................................................36
Print Profiles.................................................................................................................................42
Printers...........................................................................................................................................47
Printer Paper Sizes.......................................................................................................................49
Applications....................................................................................................................................52
Network Settings..........................................................................................................................55

# PRINT AUDIT 5 JOB MANAGER
Welcome............................................................................................................................................60
Finding, Viewing and Editing Jobs................................................................................................60
Job Reporting..................................................................................................................................66
Job Exporting...............................................................................................................................70
Advanced........................................................................................................................................79

# PRINT AUDIT 5 ANALYSIS REPORTING
Overview...........................................................................................................................................80
Understanding the Analysis Reporting Tool................................................................................81
Grouping and Filtering..................................................................................................................82
Reports...........................................................................................................................................86

# PRINT AUDIT 5 JOB MERGE WIZARD
Welcome............................................................................................................................................89
Requirements.................................................................................................................................90
Before You Begin..........................................................................................................................90
General Usage..............................................................................................................................91
Importing..........................................................................................................................................92
Exporting..........................................................................................................................................96

# PRINT AUDIT 5 DATABASE MAINTENANCE TOOL
Welcome............................................................................................................................................99
Access Maintenance.......................................................................................................................99
Print Audit 5 Overview

Welcome

Welcome to Print Audit 5! The latest version of Print Audit offers many new features as well as improvements on previous features. Print Audit takes its customer's feedback and suggestions seriously. Over ninety percent of the new features and changes from Print Audit 4 were taken directly from customers. We believe Print Audit 5 is the best solution available for printing recovery, analysis and reduction.

Getting Started

Print Audit 5 is a very simple product to use. Even novice users can have Print Audit up and tracking printing in a matter of minutes. However, users can find any new product overwhelming at first. This section will answer the following questions:

• What exactly is Print Audit?
• What tools are available with Print Audit?
• I have installed Print Audit, but what do I do next?

Print Audit Overview

Print Audit is the premier product on the market for tracking your printing costs. You can use Print Audit for any combination of the three tasks below.

Analysis

You can use Print Audit 5 to analyze printing in your organization. Print Audit gathers all printing information and stores it in our database. You can then run reports against your printing information to determine high volume printers, peak printing times and your highest volume users.

Recovery

You can use Print Audit 5 to recover your printing costs. You can use our highly configurable Print Audit Client Popup window to have your users enter information you can use to assign printing costs to customers or projects. You can configure Print Audit to ask for up to five different pieces of information to help you appropriately cost and assign the job.
Reduction

You can use Print Audit 5 to significantly reduce your printing costs. You can ensure users are printing in duplex mode, control which printers are allowed to print in color and control the size of job that a printer can print.

With these sorts of controls you can ensure your users are printing in a cost-effective manner.

Print Audit Tools

The Print Audit 5 suite consists of several tools. These tools help you install, configure and report on your print tracking. Please note that you may not be able to use all of the features and tools described depending on your licensing. The tools are listed below:

Main Tools

- **Client** - The Print Audit Client tracks all printing from a user's desktop. You must install the Client on any computer from which you want to track printing. The Client can also gather custom information from your users at print time.
- **Client Communicator** - The Client Communicator handles all communication between the Print Audit Client and the Print Audit database. You generally only need to install one Client Communicator in your organization.
- **Administration** - You use the Administration tool to configure all aspects of Print Audit 5. You use it to setup printer profiles, user profiles and any custom field information. You also use the Administration tool to configure printing limits and other reduction features.
- **Job Manager** - You use the Job Manager to view, edit and delete your print job information. You can also use the job manager to report detailed job information and export your jobs to other tools.
- **Analysis Reporting** - You use the Analysis Reporting tool to generate sophisticated reports that you can use to report on volumes and calculate ROI on your information.
- **Print Audit Database** - The Print Audit database stores all of your print job, user and printer information. You can use a Microsoft Access based database or Microsoft SQL Server. For larger organizations we highly recommend SQL Server.
Support Tools

- **Client Status/Deployment** - You use this tool to monitor the status of Print Audit Clients on your network. You can also use the tool to deploy the client to Windows NT based computers in your organization.
- **Job Merge Wizard** - You can use this tool to merge jobs from one Print Audit database to another. For example you may have several satellite offices and want all of the information merged into a head office database.
- **Database Maintenance Tool** - You can use this tool to create SQL databases, compact Access databases and change database passwords.

Print Audit Next Steps

Once you install Print Audit on one computer and see all the product has to offer there are several things you should check and configure before you roll-out the Print Audit Client to your entire organization. Note that the items below are just some of the items you can configure with Print Audit. For a full picture of the many different ways you can setup Print Audit you should read the Print Audit Administration help file.

1) **Client Communicator Location**
You must install the Client Communicator on a computer that will always be running. You do not need to install it on a server, but we recommend installing it on a Windows NT based computer. If the computer running the Client Communicator is not running Print Audit cannot track jobs.

2) **Database Type**
When using Print Audit you can choose between using a Microsoft Access database or a SQL Server database to store your Print Audit information. You should decide on your database type as early as possible. SQL Server databases are much faster and more stable than using Microsoft Access so we highly recommend it. If you do not have a SQL Server in your organization you can download Microsoft's MSDE. MSDE is a "stripped down" version of Microsoft SQL Server that should work for most organizations.

3) **Database Location**
Much the same as the Client Communicator, the database must be on a computer that will always be running. The best solution for performance reasons is to place the Client Communicator and database on the same computer. If you are using Microsoft Access this is especially important.
Also important for Access databases is that you must share the folder containing the Access database to all users on your network. Only the Print Audit Client uses the Client Communicator, the other tools connect directly to the database. You need to give your users full access to the folder.

4) Setting your Printing Costs
You can use Printer Profiles in the Administration tool to configure how much your printing is going to cost. You can configure costing by page, paper size, square feet or square meters. If you need different tracking types for different printers you can configure a different profile for each different way of tracking.

5) Configuring the Popup
First you need to decide if you want to use the Popup window. You can configure if the Popup window appears based on application, printer and user. If you want to track silently you need to make sure all tracking options are set to "Track with no Popup.

If you do want to use the Client Popup, you use the Client Settings and Custom Fields section of the Administration tool to configure the appearance and behavior of the Popup window.

6) Network Type (Advanced)
By default Print Audit assumes a "peer to peer" network. This means that Print Audit stores users to the database using just their network login name. If you want to track users from multiple domains, or want to use Novell for your user authentication you should choose a different network type. You select the network type in the Advanced\Network Settings section of the Print Audit Administration tool.

Print Audit 5 How To Guides

How to Set the Cost Per Page for a Printer

Print Audit assigns costs to printers through the use of "Printer Profiles". Print Audit assigns a profile to your printer the first time you print to the printer when Print Audit is running. Once a printer is visible in the Administrator component, you can follow the detailed steps below to assign it a cost per page.

1. Go to the Printers section in the Print Audit Administrator
2. If your printer is not listed, send a print job to it and then press the "Refresh" button on the Print Audit 5 Administrator’s toolbar.
3. Once your printer is listed, check what profile it is using by looking under the Profile column.
4. Go to the “Printer Profiles” tab and double-click on the name of the profile from the previous step.
5. A new window will be displayed that includes fields for pricing options and costs.
6. Select “per page” for the Pricing option field.
7. Type the desired cost per page in dollars and cents in the “cost per” field.
8. Click the Save button to commit changes.

NOTE: You can assign the same profile to many printers in your organization, each printer does NOT require a unique profile.

How to Set Declining Balances for Users

You can set declining balances for users to restrict how much printing they are allowed to do. You set declining balances using Tracking Profiles that you assign to users. Print Audit automatically adds users to Print Audit the first time it tracks their printing. However you can also import users from a list, or from your domain. Once a user is visible in Print Audit 5 Administrator you can assign declining balances as follows:

Turn on declining balances in the profile:

1. Go to the User Profiles section of the Print Audit Administration tool and click the Tracking Profiles tab
2. Double-click the tracking profile you want to change. The Track Profile Edit window appears. NOTE: You may want to create a new tracking profile as changes to a profile affect all users assigned to the profile.
3. Click the Cost/Balances tab on the edit window.
4. Check the Use declining balances checkbox. This turns on declining balances for ALL users assigned to the tracking profile.
5. Enter the initial balance amount in the Starting field. Print Audit automatically deducts costs of printing from this number until it reaches zero.
6. You can also optionally enter an overdraft amount in the Overdraft field.
7. Double-check the other tracking settings to make sure they are correct.
8. Click the Save button to save the changes to the profile.

Assign users to the tracking profile:

1. Go to the Users section of the Administration tool.
2. Select user accounts you want to assign to the profile. You can use CTRL+click and Shift+Click to select multiple users.
3. Click the Edit button on the toolbar.
4. Use the Track Profile drop down to select the tracking profile you want.
5. Click **Update**. A message box appears asking you if you are sure.
6. Click **Yes** to set all users to the new tracking profile.

**How to Restrict Access to the Administration Tool**

You can secure the Print Audit 5 Administrator so that only authorized people can make changes to Print Audit settings. Print Audit automatically gives the first person to use Print Audit "administrator" access. This person has full access to Print Audit. Subsequent users are not given access to the Administrator.

To give a user access to the Administration tool:

1. Someone who already has Administration access must run the Print Audit Administration tool.
2. Go to the **Users** section of the Administration tool to view the list of users.
3. Double-click on the user you want to give Administration access to. The User Edit window appears.
4. Use the **Security** drop down box on the **Profiles** tab to select the "Print Audit Administrator" profile.
5. Click the **Save** button to save the changes to the user.

To require a valid PIN code to access the Administration tool:

1. Follow the instructions here to assign a PIN code to a user with Administration access.
2. Go to the **Client Settings** section of the Administration tool.
3. In the **Authentication** section, change the "Required authentication before users can use other Print Audit tools" to PIN code.
4. Click the **Save** button on the toolbar.

**How to Require PIN Code Entry Before Printing**

Requiring PIN code entry consists of two main steps. First you have to assign PIN codes to your users, then you must configure Print Audit to ask for the PIN code every time the user prints.

To assign PIN codes to individual users:

1. Go to the **Users** section in the Print Audit Administration tool.
2. Double-click on the user you wish to assign a PIN code.
3. Enter the desired PIN code in the "PIN Code" field.
4. Press “Save” button to commit changes.
To assign PIN codes to all users:

1. Go to the **Users** section in the Print Audit Administration tool.
2. Go to the **Tools->Generate PIN Codes** menu item. The **Generate PIN Codes** window appears.
3. Select the PIN code generation options and click **Generate**. Print Audit generates PIN codes for all the users.

To view the list of PIN codes generated for the users, export all users to a flat file. The PIN codes are exported with the users.

NOTE: Print Audit can also automatically assign PIN codes to users if you import a list into the database.

To configure Print Audit to ask for the PIN code every time the user prints:

1. Go to the **Client Settings** section in the Print Audit Administrator.
2. Under the Authentication section, change “Required authentication before users can print” to “PIN code”.
3. Press “Save” button to commit changes.

**How to Redirect Print Jobs to More Efficient Printers**

To redirect print jobs to more efficient printers you need to add a "printing limit" to the Printer Profile of the more inefficient printers. If a user prints a job over the page limit to an inefficient printer, Print Audit displays a message to the user printing and optionally cancels the print job.

This allows you to "train" your users to use more efficient printers for larger jobs.

**To create a printing limit on a Printer Profile:**

1. Go to the **Printer Profiles** section of the Administrator.
2. Double-click the printer profile you want to change. The Printer Profile Edit window appears. NOTE: You may want to create a new printer profile instead as any changes you make to a profile affect all printers that use the profile. Click on the **Printing Limits** tab. You should see a list of any existing printing limits with three buttons at the top.
3. Click the **Add** button to add a new page limit. The Adding a Limit window appears.
4. Enter the maximum number of pages you want the user to print to the **Limit** box.
5. Enter a message you want displayed to the user when they exceed the limit in the **Message** box. You may want to recommend an alternate printer in this message.

6. Check the **Stop job at limit** if you want Print Audit to cancel the job if it exceeds the limit.

7. Click the **OK** button to finish adding the limit.

You can repeat steps 4 through 8 to add different "levels" of limits. For example you may want to only warn the user about exceeding a 5 page limit, but if it exceeds a 10 page limit you want to stop the job.

### To assign a printer profile to a printer:

1. Go to the **Printers** section of the Administration tool.
2. Select the printers you want to assign to the profile. Use CTRL+click and SHIFT-click to select multiple printers.
3. Click the **Edit** button on the toolbar.
4. Use the **Track Profile** drop down to select the profile you want to assign.
5. Click the **Update** button. A message appears asking you to confirm.
6. Click the **Yes** button to assign the printer profile to your selected printers.

### How to Make Print Audit Track Jobs With No User Interaction

Print Audit allows you to set a "track option" for both User Profiles and Printer Profiles. The "track option" controls if Print Audit displays the Popup Window every time a user prints to a specific printer or not. To make sure Print Audit does not display the Popup window you need to make sure both the assigned User Profile and assigned Printer Profile have their track options set to "Track with no popup".

### To change a Printing Profile to track with no popup:

1. Go to the **Printer Profiles** section of the Administrator. A list of all of your defined Printer Profiles displays.
2. Check the **Track** column in the list. Ensure the profiles have "Track with no popup" displayed. If they do, you are done. Otherwise continue to the next step.
3. Double-click on the Printer Profile you want to change. The Profile Edit window appears.
4. Use the **Tracking option** drop down to select "Track with no popup".
5. Click the **Save** button. The Printer Profile list refreshes showing the changes.
6. Repeat steps 2 through 5 until all profiles you want to change are changed.

**To change a User Profile to track with no popup:**

1. Go to the User Profiles section of the Administrator. A list of all of your defined User Profiles displays.
2. Check the Track column in the list. Ensure the profiles have "Track with no popup" displayed. If they do, you are done. Otherwise continue to the next step.
3. Double-click on the User Profile you want to change. The Profile Edit window appears.
4. Use the Tracking option drop down to select "Track with no popup".
5. Click the Save button. The User Profile list refreshes showing the changes.
6. Repeat steps 2 through 5 until all profiles you want to change are changed.

**How to Import Values and Users from Print Audit 4**

There are two main steps you need to do to get values and users from Print Audit 4 to Print Audit 5. First you need to export the information from Print Audit 4 and then import it into Print Audit 5.

**To import validated values into Print Audit 5:**

1. Open the Print Audit 4 Administrator.
2. Click on the Validated Values tab. This may be named "Project Values" or "Client Values", depending on what you named your validated value. A list of all your validated values displays.
3. Click the Export button. A dialog appears asking you to enter in the save name and path of the export file.
4. Enter in the information and click the Save button. Print Audit exports the validated values into the file you specified.
5. Open the Print Audit 5 Administrator.
6. Go to the Client Custom Fields section.
7. Select the custom field that you want to import the Print Audit 4 values into in the top grid. You can also double-click on an empty row in the top grid to create a new custom field.
8. Click the Import button on the toolbar. The Import Values Window appears.
9. Use the Import type drop down to select "Print Audit 4 Values File".
10. Enter the filename / location of the file you specified in step 4... You can also use the “folder” button to browse for this file.
11. Click the **Import** button to start importing. Print Audit imports all the values in the file.

**To import users into Print Audit 5:**

1. Open the Print Audit 4 Administrator.
2. Click on the **Users and Security** tab. A list all of the users entered into Print Audit 4 displays.
3. Click the **Export** button. A dialog appears asking you to enter in the save name and path of the export file.
4. Enter in the information and click the **Save** button. Print Audit exports the users to the file you specified.
5. Open the Print Audit 5 Administrator.
6. Go to the **Users** section.
7. Click the **Import** button on the toolbar. The Import Users From window appears.
8. Use the **Import type** drop down to select "Print Audit 4 File".
9. Enter the filename/location of the file you specified in step 4. You can also use the "folder" button to browse for the file.
10. Use the **Track profile** drop down to select the user tracking profile you want to assign to each user.
11. Use the **Security profile** drop down to select the security profile you want to assign to each user.
12. Click the **Import** button to start importing. Print Audit imports all users in the file.

**How to Enforce Duplex Only Printing**

You can configure Print Audit 5 to allow only duplex printing to go through to a specific printer. To do this you need to configure a Printer Profile and assign it to your duplex printer. Please follow the steps below to enforce duplex only printing:

**To configure a profile for duplex only printing:**

1. Go to the **Printer Profiles** section of the Administration tool.
2. Double-click the printer profile you want to change. The Printer Profile Edit window appears. **NOTE:** You may want to create a new printer profile instead as any changes you make to a profile affect all printers that use the profile.
3. Click the **Job Options** tab.
4. Check the **Allow only duplex printing** box.
5. Click the **Save** button to save the changes to the profile.
To assign a printer profile to a printer:

1. Go to the **Printers** section of the Administration tool.
2. Select the printers you want to assign to the profile. Use CTRL+click and SHIFT-click to select multiple printers.
3. Click the **Edit** button on the toolbar.
4. Use the **Track Profile** drop down to select the profile you want to assign.
5. Click the **Update** button. A message appears asking you to confirm.
6. Click the **Yes** button to assign the printer profile to your selected printers.

**How to Charge for Printing Based on Paper Size**

To have Print Audit 5 charge for printing based on paper size you need to make changes to the Printer Profile assigned to a printer. **NOTE:** Any changes you make to a Printer Profile apply to all printers that use that profile.

To modify the Printer Profile to use paper sizes:

1. Go to the **Printer Profiles** section of the Administration tool.
2. Double-click the Printer Profile you want to change. The Printer Profile Edit window appears. **NOTE:** You may want to create a new printer profile instead as any changes you make to a profile affect all printers that use the profile. Click the **Pricing** tab if not already selected.
3. Use the **Pricing option** drop down to select "per paper size". The window updates to display all defined paper sizes and a default cost per page for those sizes.
4. You can double-click in the **Cost** column of the list of paper sizes to enter a custom cost for a specific paper size.
5. Once you are done making your cost changes if any, click the **Save** button to save the changes to the profile.

To assign a printer profile to a printer:

1. Go to the **Printers** section of the Administration tool.
2. Select the printers you want to assign to the profile. Use CTRL+click and SHIFT-click to select multiple printers.
3. Click the **Edit** button on the toolbar.
4. Use the **Track Profile** drop down to select the profile you want to assign.
5. Click the **Update** button. A message appears asking you to confirm.
6. Click the **Yes** button to assign the printer profile to your selected printers.
Print Audit 5 Administration

Welcome

Welcome to the Print Audit 5 Administration tool. You use the Print Audit 5 Administration tool to configure all aspects of Print Audit 5.

The tool consists of several sections; each one focuses on a different aspect of Print Audit 5. You may not need to use all the sections in Print Audit 5 depending on your business needs, but you should familiarize yourself with all of them to fully understand what Print Audit 5 offers.

Please note that you may not have access to all that Print Audit 5 has to offer depending on the type of licensing you purchased.

Below are links to topics describing each section of the Administration tool:

- **Client** - This section contains information on how to configure the Print Audit Client and how Print Audit tracks your print jobs.
- **Printers** - This section contains information on how to manage and configure how Print Audit tracks your printers when printing.
- **Users** - This section contains information on how to manage and configure how Print Audit tracks your users when printing.
- **Applications (Advanced)** - This section contains information on how to manage and configure how Print Audit tracks printing from different applications.
- **Network and Authentication (Advanced)** - This section contains information on advanced network configuration and other advanced topics for more complex networks.

General

Change your Database

If you have several different Print Audit databases you may need to point the Administration tool to one or the other. When you change databases Print Audit asks you for any authentication information before you can use the new database.

If you do not have rights to the new database, or Print Audit encounters some other problem the Administration tool continues to use your existing database selection.
To change your database:

1. Click the Tools->Set Database menu. A dialog appears asking you to select your new database.
2. Select the new database. For Access databases simply select the new database file. For SQL Server databases please enter the new SQL information.
3. Accept the information. Print Audit attempts to log in to the new database.

Print Audit Licensing

Print Audit 5 is licensed per computer. This means that you must purchase one license of Print Audit for each computer from which you want to track printing. If you are using a Terminal Services/Citrix environment you must purchase a license for each user that prints through the Terminal Services/Citrix server.

There are three different feature packages you can purchase with Print Audit 5. They are as follows:

- **Analysis** - This package includes all the tracking capabilities of Print Audit, and gives you access to our Print Audit Analysis Reporting tool. It does not include the ability to have users enter information on our Popup window before they print, and does not support any of our reduction capabilities such as forcing duplex printing and printing limits.

- **Recovery** - This package includes all the tracking capabilities of Print Audit. It also supports the use of our Popup window to enter in up to 6 pieces of custom information for each print job, and allows you to force the user to authenticate before they can print. It does not support any of our reduction capabilities and does not include the Print Audit Analysis Reporting tool.

- **Reduction** - This package includes all of our reduction capabilities such as forcing color and/or duplex printing and enforcing printing limits to specific devices. This package by itself does not include any tracking capabilities so your printing information is not stored to the Print Audit database.

You can combine the three above packages into any combination that fits your needs. Please contact your sales person for more information on each package combination and pricing.
Client Settings

This section of the Administration tool allows you to set general information about how the Print Audit Client behaves on the desktop. It controls things such as if you want to allow the user to shutdown the Client, whether or not it supports batching and how users have to authenticate before they can print.

Listed below are all the options you can set in this section:

General Settings

This section controls in general how the Print Audit Client behaves on the Windows desktop.

- **Display Tray Icon** - If set to *Yes* a tray icon displays in the Windows task bar area when the Print Audit Client is running.
- **Wait for Page Count (Recovery only)** - If set to *Yes*, Print Audit does not display the Popup window until it has the page count. This can cause a delay before the Print Audit window appears. If set to *No*, Print Audit does not display the final job cost or final number of pages on the Popup window.
- **Shutdown the Client** - If set to *Yes* the user can shutdown the Print Audit Client.
- **Enter Comments (Recovery only)** - If set to *Yes* the user can enter comments on the Popup window when it displays.
• **Use Last Entries (Recovery only)** - If set to **Yes**, Print Audit automatically populates the Client Popup window with the same entries the used on the last print job.

**Batch Settings (Recovery Only)**

This section controls how the Print Audit Client controls batching. Batching is how Print Audit handles multiple print jobs when you want to re-use the same Popup Window entries as a previous job automatically. Please note that these settings have no effect if you configure the Print Audit Client to not display a popup window when printing.

**Batching Type** - There are three types of batching.
- **None**: Print Audit displays a popup on every print.
- **Automatic**: Print Audit automatically re-uses the same popup window entries for all jobs that you print within the batch timeout from the same program.
- **Manual**: Print Audit allows you to enter the number of jobs you want to batch on the popup. Print Audit automatically re-uses the popup settings for the number of jobs you indicated or until the time-out expires.

**Maximum Batch Size** - This displays only for the **Manual** batch type. You enter the maximum number of jobs you want the user to batch here.

**Batch Time-out** - Use this to enter the number of seconds Print Audit waits before canceling a batch. This indicates the time-out between jobs, not overall. For example, if you enter 60 seconds for the time-out and set the batch size to twenty jobs, Print Audit automatically cancels the batch if more than a minute elapses before it detects the start of the second job in the batch.

**Authentication**

This section controls how Print Audit authenticates Print Audit users. Print Audit determines who the user is before allowing access to the Print Audit tools and before it allows them to print.

**Client Authentication** - This controls how the Print Audit Client determines who the user is. Use the drop-down box to choose an authentication type.

There are three authentication types. They are as follows:
- **Logged in User** - Print Audit uses the current Windows or Novell login information to identify the user.
- **PIN Code** - Print Audit requires the user to enter their Print Audit PIN code to identify the user.
- **Network** - Print Audit requires the user to re-enter their Windows or Novell login information to identify the user. Print Audit does not store or transmit this information anywhere. Please note that this type of authentication may not work properly on Windows 95, Windows 98 and Windows Millennium depending on your network configuration.

**Tools Authentication** - This controls how the Print Audit Administration, Job Manager and other tools determine who the user is. Use the drop-down box to choose an authentication type. The authentication options for both Client and Tools are identical.

You can set **Client Authentication** per computer, and choose to report the users as Windows NT, Active Directory or Novell Directory Services. For more information on these advanced settings, please see the Network and Authentication settings section.

**Email Notifications**

This section allows you to configure Print Audit to send email notifications to an administrator in your organization in case of licensing problems. You can also have Print Audit automatically send the same notification to Print Audit so we can better serve your needs.

**SMTP Server** - Enter your internal SMTP email server name or address here. Print Audit uses this server to send all notification emails. Please note that if you are not authorized to use this server Print Audit cannot deliver the emails.

**Email Address** - Enter the email address of the person you want notified in case of licensing issues. Generally you should enter the email address of the person in your organization responsible for administering Print Audit.

**Send Email to Print Audit** - Select "Yes" to have Print Audit send an email to our licensing department in case of licensing issues. Print Audit sends no private information, simply your Print Audit licensing information and the nature of the problem. We use this information to then contact you and help you with your problem.

Select "No" (the default) if you do not want to notify Print Audit of licensing issues. If selected, no information is sent to us.
Advanced Settings

This section allows you to set advanced Print Audit Client settings. Please only adjust these settings if you have advanced requirements.

**Client TCP/IP Port** - Please enter the TCP/IP port you want the Print Audit Client to listen on here. The default port should be fine for most situations. The Print Audit Client uses this port to accept communications from some other Print Audit tools, including the Print Audit Client Status/Install tool.

You must make sure that this port is not the same as any other program on the client computer.

**Client Custom Fields**

![Client Custom Fields Window](image)

**Custom Field Value Window**

Use this window to add/edit custom field values. Enter all information applicable to the field and value you are setting up. You may not need to enter information for everything, depending on your business needs.

**General**

- **Code** - An alphanumeric value that Print Audit uses as a unique identifier for this value. Examples of codes are accounting codes, client codes, project codes, etc. Each value must have a unique code. Codes
only need to be unique within a field. For example, if you have two custom fields, one called Project and the other Customer, you could have a value in each with the code "001". However, you could not have two "001" values under Project.

- **Description** - This is a user-friendly description of the value. For example, if you have a custom field called "Customer", this could correspond to the customer's name.
- **Is Active** - This check box determines if the value is active. If active it shows up on the popup. If not active, it is not selectable by the user. This allows you to keep expired codes in the database for reporting purposes but not allow users to assign jobs to the code.

### Job Cost

- **Modifier** - This is a percentage or direct cost modifier applied to the print job if the user selects this value on the Print Audit Client Popup. The **Modifier Type** determines how Print Audit applies the modifier.
- **Modifier Type** - Use this to select the type of modifier for the value. Different types affect the cost of the job in different ways. For more information, see Modifier Types.
- **Use Budget** - Check this box if you want to use a budget for this value. Print Audit subtracts the cost of the print job from the budget for the value if the value was used on that print job. Once the budget reaches zero, a user can no longer print a job to the value. Use this if you have strict costing requirements for projects, customers, etc.
- **Budget** - This reflects the current budget for the value. If zero and **Use Budget** is checked, Print Audit will no longer allow users to print jobs to this code.

### Last Modified

- **Modified By** - This displays the name of the Print Audit user who last modified this value.
- **Modified Date** - This displays the last date this value was modified.

### Cost Modifier Types

Print Audit supports cost modifiers that can dramatically alter the cost of a print job. Print Audit potentially applies cost modifiers based on color, user and custom values. Each modifier is one of four types. The types of modifiers are listed below:

- **Unit Cost** - Print Audit applies Unit Cost modifiers to each and every "unit" of the print job. The unit is one of pages, square feet or square...
meters, depending on printer configuration. For example, if a modifier of ten cents per unit is applied to a ten page job, and units are pages, then there will be a dollar added to the cost of the job.

- **Unit Percentage** - Print Audit applies Unit Percentage modifiers to each and every "unit" of the print job. A percentage of "100" does not change the cost at all. A percentage of "200" would double the unit cost, a percentage modifier of "0" would zero out the unit cost.

- **Job Cost** - Print Audit applies job cost modifiers to the final cost of the job. For example, a job cost modifier of five dollars would add five dollars to the cost of the final job, regardless of the number of units.

- **Job Percentage** - Print Audit applies job percentages to the final total of the job, once all other modifiers are taken into account. A percentage of zero will make the job have no cost regardless of any other modifier.

For more information on how Print Audit uses these modifiers, see Calculating Job Cost. It is important to note that Print Audit applies Job Percentage modifiers after all other modifiers, where it applies Unit Percentage modifiers before any Job Cost modifiers. This order can cause a 50% unit cost modifier to have a much different effect than a 50% job cost modifier depending on what other modifiers are present.

**Overview**

Print Audit 5 allows you to define up to five custom fields the user must enter information for before they can print. Each one of these custom fields can have completely different values and types, allowing you to gather from your users valuable business information for each print job.

Your users MUST enter information on the Print Audit Client Popup for each custom field you define. If you have simpler needs and just want them to enter optional free form information, you should turn on the **Comments** field. For more information on this field, see the help on the **Client Settings** section.

For users upgrading from Print Audit 4, Client Custom Fields are equivalent to the Validated Values functionality, only with more options.

The Client Custom Fields section consists of two main grids. The top grid contains a list of all the custom fields you define. The bottom grid contains a list of all the values you enter for a specific field. To see values for a field, click on the field in the top grid to select it. All of the values automatically display in the bottom grid.
You can also configure Print Audit to require different custom field information depending on who is printing. For more information see the User Profiles section.

Custom Field Types

When you create a custom field you can choose from one of four custom field types. The field types you can choose from are as follows:

- **Searchable** - This field type uses a separate popup search window for searching on values from the Print Audit Client. It is similar to the Print Audit 4 Validated Value field. It keeps track of the last ten used values and supports an unlimited number of values. This field type also supports adding new values from the Print Audit Client.

- **Searchable Drop down** - This field type uses a type-ahead drop down box search so the user does not need to use a separate search window. It keeps track of the last ten used values, but only supports fields that have up to one thousand values. This field type supports adding new values from the Print Audit Client.

- **Simple Drop down** - This field type is not searchable, a user simply selects an entry from the drop down. It does not keep track of the last ten used values, and only supports fields that have up to one hundred values. It does not support adding new values from the Print Audit Client. This field works best for a small set of selectable items for a print job, such as added materials needed like binding or shipping. This field type is similar to the Paper Types field in Print Audit 4 only more configurable.

- **Option** - Not searchable, displays a pair of option buttons for the field. It supports only two values. Used generally for "yes, no" options like Billable and Non-Billable for example.

Adding, Editing and Deleting Custom Fields

You use the Client Custom Fields section of the Administration tool to add, edit and delete custom fields. You can also change the order in which the custom fields appear on the Client Popup window. Please follow the steps in the sections below.
To add a new custom field:
1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Double-click on an empty row in the top list in the Client Custom fields section or click in the top list and then click the New button on the toolbar. The Adding New Field window appears.
3. Enter the name of the field in the Name text field. This name depends on your business, but examples are Project, Client, Account, etc. You must enter a unique name for each custom field.
4. Select the type of field from the Type drop down.
5. Click the Save button. The Adding New Field window closes and you should see your new field listed in the top list.

To edit an existing custom field:
1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Double-click on the field you want to edit in the top list in the Client Custom fields section. The Editing Field window appears.
3. Make your changes as appropriate. See the above section to see the fields you can change.
4. Click the Save button. The Editing Field window closes and you see your changes displayed in the top list.

To change the order of a custom field:
1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field you want to move in the top list in the Client Custom fields section. The row containing the field is highlighted.
3. Click the Up or the Down arrow buttons on the toolbar at the top of the Administration window to change the order of the custom field.

To delete an existing custom field:
1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field you want to delete in the top list in the Client Custom fields section. The row containing the field is highlighted.
3. Click the Delete key on the toolbar at the top of the Administration window. A message appears asking you to confirm you want to delete the field.
4. Click the **Yes** button on the message box to delete the field. The top list refreshes to show the field was deleted.

**NOTE:** You cannot delete a custom field if it is referenced in a database print job.

**Adding, Editing and Deleting Custom Field Values**

You use the Client Custom Fields section of the Administration tool to add, edit and delete custom values for a field. Please follow the steps in the sections below.

**To add a new custom value:**

1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field you want to add values for in the top list. A list of all values for that field appear in the bottom list.
3. Double-click on an empty row in the bottom list in the Client Custom fields section, or click in the bottom list and click the **New** button on the toolbar. The **Adding New Value** window appears.
4. Enter the information for the new value.
5. Click the **Add** button. The value saves to the database and the window sets up to add the next value.
6. Click the **Close** button if you are done adding values. This will close the window and refresh the values. You can also continue steps 4 through 5 to continue adding values.

**To edit an existing custom value:**

1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field you want to edit values for in the top list. A list of all values for that field appear in the bottom list.
3. Double-click on the value you want to edit in the bottom list in the Client Custom fields section. The **Editing Value** window appears.
4. Make your changes as appropriate.
5. Click the **Save** button. The **Editing Value** window closes and you see your changes displayed in the top list.
To edit multiple custom values at once:

1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field you want to edit values for in the top list. A list of all values for that field appear in the bottom list.
3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of values you want to edit.
4. Click the Edit button on the toolbar. The Editing Value window appears. Please note that not all fields are editable when making changes to multiple values at once.
5. Make your changes as appropriate.
6. Click the Save button. The Editing Value window closes and you see your changes displayed in the top list.

To delete existing custom values:

1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field you want to delete values for in the top list. A list of all values for that field appear in the bottom list.
3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of values you want to delete. If you want to delete only one value, you can simply click on it.
4. Click the Delete key on the toolbar at the top of the Administration window. A message appears asking you to confirm you want to delete the value(s).
5. Click the Yes button on the message box to delete the values. The bottom list refreshes to show the values were deleted.

NOTE: You cannot delete a custom field value if it is referenced in a database print job.

Importing Custom Field Values

Print Audit allows you to import custom field values from a comma-delimited file on a one time or scheduled basis. This allows you to keep your master list of values in an accounting package or other piece of software and easily synchronize them with the codes in Print Audit. You can also import values from Print Audit 4 if you are upgrading.
To import values into a field:

1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field for which you want to import values in the top grid. The field row is highlighted.
3. Click the Import button on the toolbar at the top of the Administration window. The Import Values window appears.
4. Select the Import Type using the drop down on the window Import Values window. See Custom Value Import Formats for a description of the different import formats.
5. On the Import tab, select the file containing the values you want to import. Please note that this file must be in the format specified by the import format you selected in step 4.
6. Check the Advanced tab to ensure settings are appropriate for what you want to do. See the Import Values window help for more information on the Advanced tab.
7. Click the Import button. Print Audit begins to import the values from the file.
8. Once the import is complete, a message displays indicating whether or not the import was successful. The import window closes and the list refreshes.

To run the import on a scheduled basis:

1. To run scheduled, simply follow the steps 1-6 in the above section. Then:
2. Check the scheduling settings on the Scheduling tab on the Import Values window. Ensure the settings reflect the type of schedule you want.
3. Click the Schedule button to add the task to the Windows Task Scheduler.

You can schedule a separate import for each custom field you define.

To remove a scheduled import:

1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field for which you want to cancel the import in the top grid. The field row is highlighted.
3. Click the Import button on the toolbar at the top of the Administration window. The Import Values window appears.
4. Click the **Remove Schedule** button to remove the task from the Windows Task Scheduler.

**OR**

1. Remove the task from the Windows Task Scheduler using its interface

**Custom Field Value Import Formats**

The custom value importers require that the file you want to import is in a specific format. Below are the types of importers and their format requirements.

**Print Audit 4**

This importer uses the same format as the Validated Value importing/exporting from Print Audit 4. The format is a comma-delimited file in the following order:

Code, Description, Cost Modifier, Active

- **Code** - The code for the value. Must be unique for the field. This is the only required column.
- **Description** - A user friendly description for the value. If omitted, Print Audit leaves the description of the value blank.
- **Cost Modifier** - A unit percentage modifier. If omitted, Print Audit uses a default of 100.
- **Active** - Whether or not the code is currently active. A value of 0 means inactive, 1 means active. If blank, Print Audit assumes active.

**Print Audit 5**

This importer uses a comma-delimited file format. The columns are in the following order:

Code, Description, Modifier Type, Cost Modifier, Use Budget, Budget, Active

- **Code** - The code for the value. Must be unique for the field. This is the only required column.
- **Description** - A user friendly description for the value. If omitted, Print Audit leaves the description of the value blank.
- **Cost Modifier** - The cost modifier. If omitted assumes zero for cost modifier types, 100 for percentage modifier types.
- **Modifier Type** - A number indicating the type of modifier. 0 - Unit cost, 1 - Unit percentage, 2 - Job cost, 3 - Job percentage. If blank, Print Audit assumes unit percentage.
• **Use Budget** - Whether or not this value uses a budget. 0 - Not using a budget, 1 - Using a budget.
• **Budget** - The amount in the budget for this value.
• **Active** - Whether or not the code is currently active. A value of 0 means inactive, 1 means active. If blank, Print Audit assumes active.

**Exporting Custom Field Values**

You can export the custom values for a field to a comma-delimited file. You can then use this file for importing into other programs that may need the value list. Print Audit exports the value information in the following order:

Code, Description, Modifier Type, Cost Modifier, Use Budget, Budget, Active

**To export custom field values from a field:**

1. Click on the Client Custom Fields button on the left hand side of the Administration window. The Client Custom Fields section appears in the right hand side.
2. Click on the field for which you want to export values in the top grid. The field row is highlighted.
3. Click the **Export** button on the toolbar at the top of the Administration window. A standard Windows dialog appears.
4. Use the dialog to select a file to export the information to and click the **Save** button. The information starts to export.
5. After the export completes a message box appears letting you know how many values were exported.

**Import Values Window**

This window allows you to configure scheduled importing of values as well as doing one time imports. The window is as follows:

**General**

**Import Type** - Use this drop down box to select the import type. The import type defines the format of the data to import.

**Import Tab**

Use this tab to select the file that you want to import values from. This file must follow the format specified by the import format.
Import - Type the name of the file you want to import in this text box, or use the button to the right to browse for the file.

Advanced Tab

Use this tab to set advanced functionality for the import.

- **Only add new values** - Select this option to add values from the file to the Print Audit database only if they do not already exist in the database.
- **Add new and overwrite** - Select this option to add new values and overwrite existing values in the Print Audit database with the information from the import file.
- **Set to inactive if not existing** - Check this box to have Print Audit set values in the database to inactive if they are not present in the import file.

Scheduling Tab

Use this tab to set how often you want the import to run if scheduled. This is a subset of scheduling options you can use with Microsoft's Windows Task Scheduler. For full featured scheduling, you can use the Windows Scheduler directly.

- **Run Import** - Use this drop down to select how often to run the import. Choices are Daily, Weekly or Monthly.
- **On** - Select the day on which to run the import. This is only effective for Weekly or Monthly schedules.
- **At** - Select the time of day at which to run the import. We recommend using a time outside of regular business hours.
User Profiles

Overview

Print Audit allows you to assign tracking and security options to users with user profiles. There are two types of user profiles: Tracking Profiles and Security Profiles. You can assign the same profile to multiple users, allowing you to quickly set up how you want users to behave in Print Audit.

Tracking Profiles control how Print Audit tracks printing from the user. This includes things such as how jobs are tracked, what options they have on the Client Popup Window, if they have declining balances and any cost modifiers applied to the job for the user.

Security Profiles control what the user can do in the Print Audit tools. For example you can assign the "Print Audit Administrator" profile to a user to give them full access to configure Print Audit 5. You can set individual Print Audit policies to control things such as user management, printer management and job exporting.

Print Audit assigns the first user to use the Print Audit Administration tool as the Print Audit Administrator, all subsequent users are given "Standard" access. If you want new users to have other profiles than these defaults, you can use this section to assign different defaults. You MUST have one user at all times as the Print Audit Administrator. Print Audit does try to protect you...
from removing the last administrator. If you somehow do remove the last Administrator you will not be able to use the Administration tool at all.

Print Audit ships with some standard profiles already defined. You can modify these profiles to suit your business needs, or create new profiles to assign. We recommend you do not modify the Print Audit Administrator security profile.

**Tracking Profile Window**

Use this window to add/edit user Tracking Profiles. Tracking Profiles control how jobs are tracked when a specific user prints. They also control what appears on the Print Audit Client Popup when they print. After you create a profile you must assign it to one or more users to have it take effect.

**General**

- **Name** - This is the name of the profile as it appears in the list.
- **Tracking option** - This is the tracking option used when a user with this profile prints.
- **Allow Color Printing** - If checked, a user with this profile can print color jobs. If unchecked and Print Audit detects a color print job a message displays to the user and they cannot print.

**Cost/Balances Tab**

- **Cost Modifier** - Enter the cost modifier to use for the job when a user with this profile prints.
- **Cost Modifier Type** - Use the drop down to select the type for the cost modifier.
- **Use Declining Balances** - Check this box to have users with this profile use declining balances. When a user's declining balance reaches zero they can no longer print.
- **Starting Balance** - Enter the starting balance for a user using this profile here. When Print Audit detects a new user assigned to this profile it sets their balance to this value.
- **Balance Overdraft** - Enter how far a user can go into the negative and still print.

**Client Options Tab**

- **Allow snooze jobs** - Check this box to allow users to "snooze" jobs. Snoozing jobs refers to allowing the user to delay entering Client Popup information to a later time of their choosing.
• **Maximum snooze jobs** - Enter into this box the number of jobs a user can "snooze" before they must enter information. If they reach this maximum number of snoozed jobs they can not print until they enter the Popup information.

• **Allow override costs** - Check this box to allow users to override costs on the Client Popup window. Print Audit accepts whatever values they enter on the Popup for costs, ignoring any cost modifiers and other costing information.

• **Show costs on popup** - Check this box to display costs on the Client Popup window. If unchecked, no job cost information displays to the user.

• **Allow adding new values** - Check this box to allow users to add new values for custom fields on the fly. Please note that you can only add new values for certain types of custom fields.

**Client Custom Fields Tab**

This tab contains a list of all defined Client Custom Fields. You can choose whether or not to include any combination of defined custom fields for this Track Profile. If included, the user must enter information for the custom field on the Popup before they can continue printing.

**To include a custom field:**
- Check the **Include** column in the list and save the profile.

**Setting the Default User Tracking Profile**

Print Audit uses a Tracking Profile you select as the "default" profile. Print Audit automatically assigns this default profile to users the first time they print.

You can change the default Tracking Profile at any time. When you change the default it only affects new users it does not change existing users in the User list.

**To set the default Tracking Profile:**
1. Click on the User Profiles button on the left hand side of the Administration window. The **User Profiles** section appears in the right hand side.
2. Click the Tracking Profiles Tab in the User Profiles section. A list of all defined Tracking Profiles appears.
3. Use the **Default Profile** drop down box located at the top of the tab to select the new profile to use as the default. Print Audit now assigns
the profile you selected to any new users that appear in the Users section.

Adding, Editing and Deleting Tracking Profiles

You use the User Profiles section of the Administration tool to add, edit and delete Tracking Profiles. Please follow the steps in the sections below.

To add a new tracking profile:
1. Click on the User Profiles button on the left hand side of the Administration window. The User Profiles section appears in the right hand side.
2. Click the Tracking Profiles Tab in the User Profiles section. A list of all defined Tracking Profiles appears.
3. Double-click on an empty row in the Tracking Profiles list, or click the New button on the toolbar. The Tracking Profile window appears.
4. Enter the information for the new profile.
5. Click the Add button. The value saves to the database and the window sets up to add the next profile.
6. Click the Close button if you are done adding profiles. This will close the window and refresh the profiles. You can also continue steps 3 through 4 to continue adding profiles.

To edit an existing tracking profile:
1. Click on the User Profiles button on the left hand side of the Administration window. The User Profiles section appears in the right hand side.
2. Click the Tracking Profiles Tab in the User Profiles section. A list of all defined Tracking Profiles appears.
3. Double-click on the Profile you want to edit in the profile list. The Tracking Profile window appears.
4. Make your changes as appropriate.
5. Click the Save button. The Tracking Profile window closes and you see your changes displayed in the list. Please note that if you change the balance information Print Audit asks you if you want to reset your balances.

To delete existing tracking profiles:
1. Click on the User Profiles button on the left hand side of the Administration window. The User Profiles section appears in the right hand side.
2. Click the Tracking Profiles Tab in the User Profiles section. A list of all defined Tracking Profiles appears.

3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of profiles you want to delete. If you want to delete only one profile, you can simply click on it.

4. Click the **Delete** key on the toolbar at the top of the Administration window. A message appears asking you to confirm you want to delete the profiles(s).

5. Click the **Yes** button on the message box to delete the profiles. The list refreshes to show the profiles were deleted.

**NOTE:** You can only delete a profile if no users exist that use it.

### Resetting User Balances

You can easily reset the balances for every user in a Tracking Profile. You may want to reset the balances at the start of every month, or using some other criteria that makes sense for your business. Please note that Print Audit automatically asks you if you want to reset user balances when you change the starting balance on the profile window.

**To reset user balances:**

1. Click on the User Profiles button on the left hand side of the Administration window. The User Profiles section appears in the right hand side.

2. Click the Tracking Profiles Tab in the User Profiles section. A list of all defined Tracking Profiles appears.

3. Double-click on the Profile you want to reset balances for in the profile list. The **Tracking Profile** window appears.

4. Make sure the **Starting Balance** value on the **Cost/Balances** tab on the **Tracking Profile** window contains the value you want.

5. Click the **Reset User Balances** button. The **Reset Balances** window appears.

6. Click the option corresponding to the balance option you want.

7. Click the **Update** button. A message appears asking you to confirm you want to update the balances.

8. Click **Yes** to set the balances of all users that use the profile.
Setting the Default User Security Profile

Print Audit uses a Security Profile you select as the "default" profile. Print Audit automatically assigns this default profile to users the first time they print.

You can change the default Security Profile at any time. When you change the default it only affects new users it does not change existing users in the User list.

To set the default Security Profile:

1. Click on the User Profiles button on the left hand side of the Administration window. The User Profiles section appears in the right hand side.
2. Click the Security Profiles Tab in the User Profiles section. A list of all defined Security Profiles appears.
3. Use the Default Profile drop down box located at the top of the tab to select the new profile to use as the default. Print Audit now assigns the profile you selected to any new users that appear in the Users section.

Adding, Editing and Deleting Security Profiles

You use the User Profiles section of the Administration tool to add, edit and delete Security Profiles. Please follow the steps in the sections below.

To add a new security profile:

1. Click on the User Profiles button on the left hand side of the Administration window. The User Profiles section appears in the right hand side.
2. Click the Security Profiles Tab in the User Profiles section. A list of all defined Security Profiles appears.
3. Double-click on an empty row in the Security Profiles list, or click the New button on the toolbar. The Security Profile window appears.
4. Enter the information for the new profile.
5. Click the Add button. The value saves to the database and the window sets up to add the next profile.
6. Click the Close button if you are done adding profiles. This will close the window and refresh the profiles. You can also continue steps 3 through 4 to continue adding profiles.
To edit an existing security profile:

1. Click on the User Profiles button on the left hand side of the Administration window. The User Profiles section appears in the right hand side.
2. Click the Security Profiles Tab in the User Profiles section. A list of all defined Security Profiles appears.
3. Double-click on the Profile you want to edit in the profile list. The Security Profile window appears. NOTE: We recommend you do not edit the Print Audit Administrator security profile.
4. Make your changes as appropriate.
5. Click the Save button. The Security Profile window closes and you see your changes displayed in the list.

To delete existing security profiles:

1. Click on the User Profiles button on the left hand side of the Administration window. The User Profiles section appears in the right hand side.
2. Click the Security Profiles Tab in the User Profiles section. A list of all defined Security Profiles appears.
3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of profiles you want to delete. If you want to delete only one profile, you can simply click on it.
4. Click the Delete key on the toolbar at the top of the Administration window. A message appears asking you to confirm you want to delete the profiles(s).
5. Click the Yes button on the message box to delete the profiles. The list refreshes to show the profiles were deleted.

NOTE: You can only delete a profile if no users exist that use it.
Users

Overview

Print Audit automatically adds every user it detects to the user list. Over time this list contains every user in your organization that has printed.

You use this list to assign tracking and security profiles, assign users to report groups, set PIN codes and check and set user balances.

User Window

Use this window to add/edit users. You do not need to fill in every part of this window, some information may not be applicable for your business.

General

- **Display name** - This is the name of the user as it appears in any reports.
- **Network name** - This the network/login name of the user. Print Audit requires that the network name of each user be unique. Depending on your network settings this can be simply the user name, a combination of domain and user or a fully qualified directory name.
• **PIN Code** - This is an optional alpha-numeric code you can assign to a user. This code must be unique for all users. You can use PIN codes for user identification and for interfacing with products like Copy Audit.

• **Report Group** - Select an existing group from the drop down or type the name of a new group. Print Audit uses this group to allow you to define custom groups to use for reporting.

**Profiles Tab**

• **Track profile** - Use the drop down box to select the track profile you want for this user. The track profile controls how Print Audit tracks printing from this user.

• **Balance** - The remaining balance for this user. Balances are used only for users with balances enabled in the tracking profile.

• **Security profile** - Use the drop down box to select the security profile you want for this user. The security profile controls what Print Audit tools the user can use.

**Adding and Deleting Users (Advanced)**

You can use Print Audit to add users to and delete users from the Users list. Print Audit automatically adds users to the list when they print, so you only need to add/delete users if you have advanced requirements. Note that if you delete a user, it may re-appear as soon as they print.

**To add a new user:**

1. Click on the Users button on the left hand side of the Administration window. The Users section appears in the right hand side. A list of all users Print Audit has tracked displays in the section.
2. Double-click on an empty row in the list or click the **New** button in the toolbar. The **User** window appears.
3. Enter information for the user as applicable.
4. Click the **Add** button. The user saves to the database and the window sets up to add the next user.
5. Click the **Close** button if you are done adding users. This closes the window and refreshes the users. You can also continue steps 3 through 4 to continue adding users.

**To delete a user:**

1. Click on the Users button on the left hand side of the Administration window. The Users section appears in the right hand side. A list of all users Print Audit has tracked displays in the section.
2. Click on the user you want to delete in the user list. The user highlights.
3. Click the **Delete** button on the toolbar at the top of the Administration tool. A message appears asking you to confirm that you want to delete.

4. Click the **Yes** button to continue deleting the user. The user list refreshes to show that Print Audit deleted the user.

NOTE: You can not delete users if they have print jobs in the database.

---

### Editing Your Users

You may need to edit your users for several reasons. You edit users to add/change PIN codes, reset their user balances and assign them to different reporting groups.

You also need to edit users to assign them to different tracking or security profiles.

**To edit a user:**

1. Click on the Users button on the left hand side of the Administration window. The Users section appears in the right hand side. A list of all users Print Audit has tracked displays in the section.
2. Double-click on the user you want to edit. The **User** window appears.
3. Change the information as appropriate.
4. Click the **Save** button. The **User** window closes and you should see changes reflected in the list.

**To edit multiple users at once:**

1. Click on the Users button on the left hand side of the Administration window. The Users section appears in the right hand side. A list of all users Print Audit has tracked displays in the section.
2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of users you want to edit.
3. Click the **Edit** button on the toolbar. The **Update Multiple Users** window appears.
4. Make your changes as appropriate. Please note that you can only change the tracking profile, security profile, balance and reporting group when editing multiple users.
5. Click the **Update** button. The **Update Multiple Users** window closes and you see your changes displayed in the list.

**To change/create PIN codes for multiple users at once:**

1. Click on the Users button on the left hand side of the Administration window. The Users section appears in the right hand side. A list of all users Print Audit has tracked displays in the section.
2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of users whose PIN codes you want to change.
3. Click the **Edit->Generate PIN Codes** menu item. The **Generate PIN Codes** window appears.
4. Enter the length of the PIN code you want to generate.
5. Check the **Numeric only** box if you want to generate numeric only PIN codes.
6. Check the **Overwrite existing** box if you want to overwrite PIN codes if they already exist. If unchecked Print Audit creates new PIN codes but does not overwrite existing PIN codes.
7. Click the **Generate** button. Print Audit generates new PIN codes for the users. To see a list of PIN codes for the users you can export the users to a flat file.

**Importing Users**

Print Audit 5 allows you to import a user list from a Print Audit 4 format flat file, a Print Audit 5 format flat file and from a domain. Please note that you can only import Windows users if you run the Administration tool on a Windows NT based computer.

NOTE: For advanced users the **Network Type** setting in the Network and Authentication Settings section controls which type of domain Print Audit attempts to import from; a Windows NT, Active Directory or Novell NDS domain.

**Import Users Window**

Use this window to import users into Print Audit from a flat file or from a Windows or Novell domain. Please note that you can only import users from a Windows domain if you are running the Administration tool on a Windows NT based computer.

**General**

- **Import type** - Select the type of import you want. See **User Import Types** for more information on the types you can select from.
- **Domain** - Enter the domain name you want to import users from. This box only appears for domain type imports. You must have rights to browse the domain to successfully import users.
- **File** - Type or use the browse button to select the file you want to import. This box appears only for Print Audit 4 or Print Audit 5 type
imports. The file must be in the proper format for the import type you select.

- **Track profile** - Select the tracking profile you want assigned to imported users.
- **Security profile** - Select the security profile you want assigned to imported users.

**PIN Code Tab**

- **Do not generate** - Select this option if you do not want Print Audit to automatically generate PIN codes for each user.
- **Generate numeric only** - Select this option if you want Print Audit to generate unique numeric PIN codes for each imported user.
- **Generate alpha-numeric only** - Select this option if you want Print Audit to generate unique alpha-numeric PIN codes for each imported user.
- **Length** - Enter the length you want for the automatically generated PIN codes. Each PIN code Print Audit generates will have this many characters/numbers.

**Advanced Tab**

- **Assign group based on OU** - Check this box if you want Print Audit to automatically create report groups for the users based on their organizational unit. This option exists only for Active Directory or Novell domain style imports.
- **Use entire tree** - Select this option if you want to use the entire organizational unit for the report group.
- **Use levels** - Select this option if you only want to use a certain range of organizational unit levels for the report group.

**To import users:**

1. Click on the Users button on the left hand side of the Administration window. The Users section appears in the right hand side. A list of all users Print Audit has tracked displays in the section.
2. Click the **Import** button on the toolbar at the top of the Administration window. The **Import Users** window appears.
3. Select the **Import Type** using the drop down on the window **Import Users** window. See **User Import Types** for a description of the different types of user imports.
4. Select the file you want to import for a **Print Audit 4/5** import, or enter the domain you want to import users from for a **Domain** type import.
Please note that the file you choose for a file-based import must be in the correct format.

5. Select the tracking profile, security profile and PIN code options for the import. See the Import Users window for more information on these settings.

6. Click the Advanced tab to view/set the automatic group creation options. See the Import Users window for more information on these settings.

7. Click the Import button. Print Audit begins to import the users.

8. Once the import is complete, a message displays indicating whether or not the import was successful. The import window closes and the list refreshes.

If you generate PIN codes for users you can export the users to get a list of all assigned PIN codes.

Exporting Users

You can export the Print Audit 5 user list to a comma-delimited file. Print Audit exports all user PIN codes so it is important to make sure you keep track of this file for security purposes.

Print Audit creates a comma-delimited file, with the columns in the following order:
PIN code, Display Name, Unique Name, Domain, Balance

To export users:

- Click on the Users button on the left hand side of the Administration window. The Users section appears in the right hand side. A list of all users Print Audit has tracked displays in the section.
- Click the Export button on the toolbar at the top of the Administration window. The Export Users To File window appears.
- Type in the file to export to, or use the browse button to select a file.
- Click the Export button on the window to export the users to the selected file.
Print Profiles

Overview

Print Audit 5 allows you to assign tracking and print cost information to printers through Printer Profiles. For example you use Printer Profiles to set whether Print Audit tracks printing from a printer, if it should track printing in pages, square footage, etc., as well as any printing limits you want to place on your printing device. You only need to create different Printer Profiles if you need to have different tracking or pricing options for different devices. You can set multiple printers to use the same Printer Profile.

Print Audit ships with two profiles already created, one for standard tracking one for ignoring printing. It sets the default profile to the tracking profile.

For users upgrading from Print Audit 4, Printer Profiles are equivalent to Printer Configurations but provide even more functionality.

Printer Profiles do not take effect until assigned to a printer or group of printers.

Printer Profile Window

Use this window to add and edit Printer Profiles. Printer Profiles control how Print Audit tracks jobs printed to printers and how it calculates costs. You also
use profiles to set up printing limits for print redirection. After you create a profile you must assign it to one or more printers to have it take effect. You may not use all parts of this window, depending on your business needs.

### General

- **Name** - Type the name of the Printer Profile here. You can name it anything you want, but we recommend something meaningful for what the profile does.
- **Track Option** - Use the drop down to select how Print Audit tracks jobs printed to printers using this profile.
- **Track Print To File** - Check this box to have Print Audit track jobs that you print to file instead of to the printer. If unchecked, Print Audit ignores jobs printed to files.

### Pricing Tab

- **Pricing Option** - Use this drop down to select how you want to charge for printing. Options include per page, per square foot, per square meter and per paper size. If you select per paper size, you can use the Printer Paper Sizes section to add or modify the paper sizes Print Audit uses.
- **Cost Per** - This is the base cost per unit charged when printing to printers using this profile. So for example if you want to charge $1.00 per square foot for printing, set the **Pricing Option** to "per sq. ft.", and set this box to 1.00. Not applicable for the "per paper size" pricing option.
- **Default** - This is the default cost per page to use if the **Pricing Option** is "per paper size" and the paper size Print Audit detects does not match any that exist in the **Printer Paper Sizes** section. Only applicable for the "per paper size" pricing option.
- **Color Modifier** - Enter any modifier you want applied to the print job cost if Print Audit detects a color job. Note that this only affects printers that support color printing.
- **Color Modifier Type** - Select the type of modifier.
- **Paper Size List** - This list displays all available paper sizes as entered in the **Printer Paper Sizes** section. You can use this list to override the default paper size cost specific to this Printer Profile. Overriding the price in this list does not affect the default cost or any other profile cost. Only applicable for the "per paper size" pricing option.
Printing Limits Tab

- **Add Button** - Click this button to add a new limit for this print profile.
- **Edit Button** - Click this button to edit an existing limit for the print profile. To edit, click the limit you want to change and then click the **Edit** button.
- **Remove Button** - Click this button to remove an existing limit for the print profile. To remove, click the limit you want to remove and then click the **Remove** button.
- **Limits List** - This list contains a list of all existing limits.

Job Options Tab

- **Allow only color printing** - Check this box to only allow color jobs to print to a printer using this profile.
- **Allow only duplex printing** - Check this box to allow duplex jobs only to print to a printer using this profile.
- **Count pages as sheets** - Check this box to have Print Audit calculate the total number of pages taking into account if the job was duplexed and if it was printed in "pages per sheet" mode. For example, a 10 page print job duplexed displays as a 5 page job if you check this box.

Setting the Default Printer Profile

Print Audit uses a Printer Profile you select as the "default" profile. Print Audit automatically assigns this default profile to printers as it adds them to the Printers list.

You can change the default Printer Profile at any time. When you change the default it only affects new printers it does not change printers that already exist in the Printer List.

To set the default Printer Profile:

- Click on the Printer Profiles button on the left hand side of the Administration window. The **Printer Profiles** section appears in the right hand side. A list of all existing Printer Profiles displays in the list.
- Use the **Default Profile** drop down box located just above the Printer Profiles list to select the new profile to use as the default. Print Audit now assigns the profile you selected to any new printers that appear in the **Printers** section.
Adding, Editing and Deleting Printer Profiles

You use the Printer Profiles section of the Administration tool to add, edit and delete Printer Profiles. Please follow the steps in the sections below.

To add a new printer profile:
1. Click on the Printer Profiles button on the left hand side of the Administration window. The Printer Profiles section appears in the right hand side. A list of all existing Printer Profiles displays in the list.
2. Double-click on an empty row in the Printer Profiles list, or click the New button on the toolbar. The Adding New Printer Profile window appears.
3. Enter the information for the new profile.
4. Click the Add button. The profile saves to the database and the window sets up to add the next profile.
5. Click the Close button if you are done adding profiles. This will close the window and refresh the profiles. You can also continue steps 3 through 4 to continue adding profiles.

To edit an existing printer profile:
1. Click on the Printer Profiles button on the left hand side of the Administration window. The Printer Profiles section appears in the right hand side. A list of all existing Printer Profiles displays in the list.
2. Double-click on the Profile you want to edit in the profile list. The Editing Printer Profile window appears.
3. Make your changes as appropriate.
4. Click the Save button. The Editing Printer Profile window closes and you see your changes displayed in the list.

To add a printing limit to a printer profile:
1. Follow the steps above to add a new profile or edit an existing profile.
2. Click the Printing Limits tab on the Printer Profile window.
3. Click the Add button on the Printer Profile window. The Printing Limit window appears.
4. Enter the number of pages you want for the limit.
5. Enter the message you want displayed to the user if they exceed the limit.
6. Check the Stop Job check box if you want Print Audit to stop the job from going to the printer if the job exceeds the limit.
7. Click the Ok button to accept the changes to the limit. The window closes and you are back at the Printer Profile window.
8. Repeat steps 3 to 7 to add more limits.
9. Click the **Add/Save** button on the **Printer Profile** window to save the changes.

**To delete existing printer profiles:**

1. Click on the Printer Profiles button on the left hand side of the Administration window. The Printer Profiles section appears in the right hand side. A list of all existing Printer Profiles displays in the list.
2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of profiles you want to delete. If you want to delete only one profile, you can simply click on it.
3. Click the **Delete** key on the toolbar at the top of the Administration window. A message appears asking you to confirm you want to delete the profiles(s).
4. Click the **Yes** button on the message box to delete the profiles. The list refreshes to show the profiles were deleted.

**NOTE:** You can only delete a profile if no printers exist that use it.

**Printing Limits and Redirection**

Print Audit 5 builds on the concept of maximum pages introduced in Print Audit 4 with printing limits. In Print Audit 5 you can setup multiple limit thresholds on a printer. At each threshold you can set a different message to display and choose whether or not to allow the job to continue if it exceeds the limit.

You setup printing limits using Printer Profiles. This allows you to define one set of limits in the profile and apply it to several printers. You can then set up a new Printer Profile with no limits and apply it to your high volume printers. This flexibility allows you to train your users to re-direct their printing to your high volume, low cost print devices to save you money.

For example, if you have an older laser printer that has significant costs per page printed that is used mainly for convenience you can create a Printer Profile and assign a limit of 10 pages and set it to stop the job if it exceeds that limit. You can enter a message for the limit that tells the user which printer they should print larger jobs to. When the user prints, Print Audit stops the job from going through to the older printer and displays the message you entered. Eventually users will start using the lower cost device automatically.
Printers

Overview

Print Audit 5 automatically adds printers to your printers list. Print Audit adds the printer the first time it detects a print job going to the printer. Over time this list contains every printing device in your organization.

You use this list to assign profiles to printers as well as maintain device specific information.

The Printer Profiles section and the Printer Paper Sizes section work with the Printers section to determine how jobs are tracked and charged. Click the links to see more information on those sections.

Adding and Deleting Printers (Advanced)

You can use Print Audit to add printers to and delete printers from the Printers list. Print Audit automatically adds printers to the list when printing, so you only need to add/delete printers if you have advanced requirements such as specialized printer matching. Note that if you delete a printer, it may re-appear as soon as someone prints to it.
To add a new printer:

1. Click on the Printers button on the left hand side of the Administration window. The Printers section appears in the right hand side. A list of all printers Print Audit has tracked displays in the section.
2. Double-click on an empty row in the list or click the New button in the toolbar. The Printer window appears.
3. Enter information for the printer as applicable.
4. Click the Add button. The Adding New Printer window closes and the new printer adds to the list.

To delete a printer:

1. Click on the Printers button on the left hand side of the Administration window. The Printers section appears in the right hand side. A list of all printers Print Audit has tracked displays in the section.
2. Click on the printer you want to delete in the printer list. The printer highlights.
3. Click the Delete button on the toolbar at the top of the Administration tool. A message appears asking you to confirm that you want to delete.
4. Click the Yes button to continue deleting the printer. The printer list refreshes to show that Print Audit deleted the printer.

NOTE: You cannot delete printers if they have print jobs in the database.

Editing Your Printers

You may need to edit printers from time to time, mainly to change the Printer Profile assigned to the printer, or to assign the printer to a different reporting group. You can also edit multiple printers at once.

To edit a printer:

1. Click on the Printers button on the left hand side of the Administration window. The Printers section appears in the right hand side. A list of all printers Print Audit has tracked displays in the section.
2. Double-click on the printer you want to edit. The Editing Printer window appears.
3. Change the information as appropriate.
4. Click the Save button. The Editing printer window closes and you should see changes reflected in the list.
To edit multiple printers at once:

- Click on the Printers button on the left hand side of the Administration window. The Printers section appears in the right hand side. A list of all printers Print Audit has tracked displays in the section.
- Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of printers you want to edit.
- Click the **Edit** button on the toolbar. The **Update Multiple Printers** window appears.
- Make your changes as appropriate. Please note that you can only change the tracking profile and reporting group when editing multiple printers.
- Click the **Update** button. The **Update Multiple Printers** window closes and you see your changes displayed in the list.

**Printer Paper Sizes**

<table>
<thead>
<tr>
<th>Paper Sizes</th>
<th>Description</th>
<th>Width (Units)</th>
<th>Height (Units)</th>
<th>Cost Per Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter (8.5 x 11)</td>
<td>8.50</td>
<td>11.00</td>
<td>in</td>
<td>$0.10</td>
</tr>
<tr>
<td>Legal (8.5 x 14)</td>
<td>8.50</td>
<td>14.00</td>
<td>in</td>
<td>$0.15</td>
</tr>
<tr>
<td>Tabloid</td>
<td>11.00</td>
<td>17.00</td>
<td>in</td>
<td>$0.15</td>
</tr>
<tr>
<td>A3</td>
<td>297.00</td>
<td>420.00</td>
<td>mm</td>
<td>$0.20</td>
</tr>
<tr>
<td>A4</td>
<td>210.00</td>
<td>297.00</td>
<td>mm</td>
<td>$0.20</td>
</tr>
<tr>
<td>A5</td>
<td>148.00</td>
<td>210.00</td>
<td>mm</td>
<td>$0.15</td>
</tr>
<tr>
<td>A6</td>
<td>105.00</td>
<td>148.00</td>
<td>mm</td>
<td>$0.10</td>
</tr>
<tr>
<td>A7</td>
<td>74.00</td>
<td>105.00</td>
<td>mm</td>
<td>$0.05</td>
</tr>
<tr>
<td>A8</td>
<td>52.00</td>
<td>74.00</td>
<td>mm</td>
<td>$0.02</td>
</tr>
<tr>
<td>Arch. A (9x12)</td>
<td>9.00</td>
<td>12.00</td>
<td>in</td>
<td>$0.10</td>
</tr>
<tr>
<td>Arch. B (12x18)</td>
<td>12.00</td>
<td>18.00</td>
<td>in</td>
<td>$0.15</td>
</tr>
<tr>
<td>Arch. C (18x24)</td>
<td>18.00</td>
<td>24.00</td>
<td>in</td>
<td>$0.20</td>
</tr>
<tr>
<td>Arch. D (24 x 36)</td>
<td>24.00</td>
<td>36.00</td>
<td>in</td>
<td>$0.25</td>
</tr>
<tr>
<td>Arch. E (30 x 42)</td>
<td>30.00</td>
<td>42.00</td>
<td>in</td>
<td>$0.30</td>
</tr>
</tbody>
</table>

**Overview**

Print Audit 5 allows you to charge for print jobs based on the size of paper used to print the job. For example, you could set a cost of $0.10 per page for Letter sized pages, and $0.15 for Legal sizes. For very large paper sizes used in plotting of large drawings, you may want to use square footage or square meter tracking instead.

To use paper size costing you need to ensure the paper sizes you use in your day to day business are included on the paper sizes list. You also need to
create or edit a **Printer Profile** set to use "per paper size" as the print option and assign that profile to your printers.

Print Audit ships with many of the standard paper sizes, you can add or modify them to suit your needs. You may want to look at each paper size and ensure the cost per page is correct for your business.

**Paper Size Window**

Use this window to add and edit Print Audit paper sizes. Print Audit uses these paper sizes to determine what amount to charge for a job if the printer is set to use paper sizes for its pricing option.

**General**

- **Name** - This is the user friendly name of the paper size.
- **Unit Type** - Use this drop down to select the unit of measure for the paper size.
- **Cost** - Enter the cost per page to charge when using this paper size.

**Measurements Tab**

Some printers report the same paper size in slightly different variations. The fields below allow you to specify a range of sizes to accept as the reported paper size.

- **From** - Enter the width and height where you want to start the range of sizes to match to this size. For example, for a Letter size (8.5 x 11), you might want to match sizes starting from 8.45 x 10.95.
- **To** - Enter the width and height where you want to stop the range of sizes to match to this size. For example, for a Letter size (8.5 x 11) you may want to match sizes up to 8.55 x 11.05.
- **Report As** - This is the size that you want the paper size reported as, regardless of range. For example, for a Letter size you want it reported as 8.5 x 11 inches.

**Adding, Editing and Deleting Paper Sizes**

You use the Printer Paper Sizes section to add, edit and delete paper sizes. Printer Profiles use these paper sizes if you set the pricing option to "per paper size".
To add a new paper size:

1. Click on the Printer Paper Sizes button on the left hand side of the Administration window. The Printer Paper Sizes section appears in the right hand side.
2. Double-click on an empty row in the bottom list in the Printer Paper Sizes section, or click the New button on the toolbar. The Adding New Paper Size window appears.
3. Enter the information for the new paper size.
4. Click the Add button. The paper size saves to the database and the window sets up to add the next size.
5. Click the Close button if you are done adding paper sizes. This will close the window and refresh the sizes. You can also continue steps 3 through 4 to continue adding sizes.

To edit an existing paper size:

1. Click on the Printer Paper Sizes button on the left hand side of the Administration window. The Printer Paper Sizes section appears in the right hand side.
2. Double-click on the paper size you want to edit in the paper size list. The Paper Size window appears.
3. Make your changes as appropriate.
4. Click the Save button. The Paper Size window closes and you see your changes displayed in the top list.

To edit multiple paper sizes at once:

1. Click on the Printer Paper Sizes button on the left hand side of the Administration window. The Printer Paper Sizes section appears in the right hand side.
2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of paper sizes you want to edit.
3. Click the Edit button on the toolbar. The Update Paper Sizes Cost window appears.
4. Enter the new cost you want to assign to the paper sizes.
5. Click the Update button. The Update Paper Sizes Cost window closes and you see your changes displayed in the list.

To delete existing paper sizes:

1. Click on the Printer Paper Sizes button on the left hand side of the Administration window. The Printer Paper Sizes section appears in the right hand side.
2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of paper sizes you want to delete. If you want to delete only one paper size, you can simply click on it.
3. Click the **Delete** key on the toolbar at the top of the Administration window. A message appears asking you to confirm you want to delete the paper size(s).
4. Click the **Yes** button on the message box to delete the paper sizes. The list refreshes to show the paper sizes were deleted.

**Applications**

![Application Window](image)

**Application Window**

Use this window to add/edit application information. Print Audit can track printing differently depending on the application printing. The information on this window tells Print Audit how to handle printing from the application. Please remember that you do not need to add every application you want to track printing from to this list. You only need to add applications where you have special printing requirements.

- **Process** - This is the name of the application's process. A process name corresponds to the name of the program's executable file. In Windows, this application name generally ends in ".exe". For example, Microsoft Word's process name is "WINWORD.EXE". You can type the process name in, or use the browse dialog to search for the process name.
- **Description** - This contains your description of the process.
- **Track option** - Use this drop down box to select the tracking option for this application.
- **Duplex only** - Check this box if you want to force users to print in duplex mode from this application.
Overview

Print Audit 5 can determine whether or not to track printing from an application. By default, all applications are watched for print jobs. However you may have instances where you want to track printing from only one application, or you want to track printing from all applications except one. You may also have instances where you do not want users to be able to print information from an application.

You can also set applications to require duplex printing. For example, you can set a program like Microsoft Word to only allow print jobs if printed in duplex mode. This can save significantly on the paper usage in your organization.

You DO NOT need to add every application you want to track to this list. Only add applications to the list if you have special tracking needs. Please note that unlike the Users and Printers list, Print Audit does not automatically add every application it detects printing from to the list.

The Applications section in the Print Audit 5 Administration tool allows you to do the following:

Adding, Editing and Deleting Applications

You use the Applications section of the Administration tool to add, edit and delete applications. Please follow the steps in the sections below.

To add a new application:

1. Click on the **Advanced** header on the left hand side of the Administration window. The list of advanced sections of the Administration tool display.
2. Click on the Applications button on the left hand side of the Administration window. The list of applications appears in the right hand side.
3. Double-click on an empty row in the list in the Applications section or click the **New** button on the toolbar. The **Applications** window appears.
4. Enter the application information as applicable.
5. Click the **Add** button. The application saves to the database and the window sets up to add the next application.
6. Click the **Close** button if you are done adding applications. This will close the window and refresh the applications. You can also continue steps 4 through 5 to continue adding applications.
To edit an existing application:

1. Click on the **Advanced** header on the left hand side of the Administration window. The list of advanced sections of the Administration tool display.
2. Click on the Applications button on the left hand side of the Administration window. The list of applications appears in the right hand side.
3. Double-click on the application you want to edit in the list in the Applications section. The **Applications** window appears.
4. Make your changes as appropriate.
5. Click the **Save** button. The **Applications** window closes and you see your changes displayed in the list.

To edit multiple applications at once:

1. Click on the **Advanced** header on the left hand side of the Administration window. The list of advanced sections of the Administration tool display.
2. Click on the Applications button on the left hand side of the Administration window. The list of applications appears in the right hand side.
3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of applications you want to edit.
4. Click the **Edit** button on the toolbar. The **Application** window appears. Please note that not all fields are editable when making changes to multiple applications at once.
5. Make your changes as appropriate.
6. Click the **Save** button. The **Application** window closes and you see your changes displayed in the list.

To delete existing applications:

1. Click on the **Advanced** header on the left hand side of the Administration window. The list of advanced sections of the Administration tool display.
2. Click on the Applications button on the left hand side of the Administration window. The list of applications appears in the right hand side.
3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of applications you want to delete. If you want to delete only one application, you can simply click on it.
4. Click the **Delete** key on the toolbar at the top of the Administration window. A message appears asking you to confirm you want to delete the application(s).
5. Click the **Yes** button on the message box to delete the applications. The bottom list refreshes to show the applications were deleted.

**Limiting the Number of Tracked Applications**

Print Audit 5 provides an extremely quick and easy way to have Print Audit limit tracking to only a few applications in your organization. For example, you can set Print Audit to track printing only from Microsoft Word without having to add every other application to the Applications list.

**To limit the number of applications you want tracked:**

1. Add the applications you do want tracked to the Applications list and set their tracking options appropriately.
2. Check the **Track only the applications in the list** button. This causes Print Audit to ignore printing from any application not in the Applications list.

**Network Settings**

![Network and Authentication Setting](image)

**Authentication Types**

Print Audit allows you to configure different types of authentication. You can choose to authenticate users before they print, or before they can use Print Audit tools.
The authentication types are as follows:

**Logged in User** - Print Audit uses the logged in user as the authenticated user. No authentication windows appear to the user. If your network type is set to Novell, Print Audit uses the logged in Novell user otherwise it uses the logged in Windows user.

**PIN Code** - Print Audit requires the user to enter their Print Audit PIN code before they can continue. Please note that you must assign PIN codes to users for this option to work.

**Network Login** - Print Audit requires the user to re-enter their network user name and password before continuing. This authentication type is not available for the "Windows Peer to Peer" network type. NOTE: This authentication type has special requirements.

**Overview**

Print Audit 5 allows you to gather network user information from several different types of networks. Print Audit supports Novell NDS networks, Windows NT 4.0 based networks, Active Directory networks and peer to peer Windows networks.

You can also configure Print Audit to require users to authenticate before they can print or use Print Audit tools. You can choose authentication with PIN codes, use existing login information or require the user to re-enter their login information. You can even choose to have a user authenticate differently for printing depending on the computer they are printing from.

Your network settings control how user information appears in Print Audit when users are added and imported.

Please note that we recommend changing these settings only if you are an advanced user with an understanding of networks and how your network is implemented.

**Network Types**

You can change the network type to change how Print Audit tracks and authenticates your users. You should change your network type to suit your requirements as soon as possible. Print Audit supports the following network types:

- **Windows Peer to Peer** - This is the default. When Print Audit adds users to the database it uses their simple login name for both the unique name of the user and the display name.
• **Windows NT Domain** - When Print Audit adds users to the database it uses the format: Domain\Username for the unique name of the user and attempts to get the full user name from the domain for the display name.

• **Active Directory** - When Print Audit adds users to the database it uses the fully qualified DN of the user for the unique name, and attempts to get the full user name from Active Directory for the display name. Note that this option is not supported when the Administrator or Client Communicator reside on a Windows 9x based computer.

• **Novell Directory Services** - Select this option if you want Print Audit to authenticate and track users against a Novell domain.

### Changing Your Network Type

Print Audit supports several different network types. Your network type controls how Print Audit reports user information as well as how it imports users. Your network type also controls how Print Audit does network authentication.

**To change your network type:**

1. Click on the **Advanced** header on the left hand side of the Administration window. The left hand list switches to the list of advanced sections.
2. Click on the **Network and Authentication** button on the left hand side of the Administration window. The section appears with the list of computers that have printed.
3. Use the **Network Type** drop down to select the type of network in your organization.
4. Click the **Save** button on the toolbar at the top of the Administration window to save the changes.

Please note that the network type changes the information of new users as they print, it does not affect existing users. If you change the network type when you have existing users, the next time they print they get added to the list with the new network information and Print Audit treats them as different users. Please be aware that when these new users are added Print Audit uses your default tracking and security profiles. This can end up with a user under one network type having different rights and tracking behavior than the user under the new network type.

For these reasons we highly recommend that you set the network type as early as possible in your Print Audit configuration and only change it if absolutely necessary.
Changing How Users Authenticate

Print Audit allows several different methods of authentication. You can configure Print Audit to require users to authenticate before they can print and authenticate before they can use the Print Audit tools.

You can set Print Audit to require different authentication methods for printing (Client Authentication) and access to the tools (Tools Authentication). For example, you may want Print Audit to use the logged in user for tracking printing but require a PIN code to get into the Print Audit tools.

Please note that the default Client Authentication and Tools Authentication settings are the same as those in the Client Settings section of the Administration tool. We provide them there as well for ease of use.

To change the default client authentication:

1. Click on the Advanced header on the left hand side of the Administration window. The left hand list switches to the advanced sections.
2. Click on the Network and Authentication button on the left hand side of the Administration window. The section appears with the list of computers that have printed.
3. Use the Default client authentication drop down to select the type of Client Authentication you want to do by default.
4. Click the Save button on the toolbar at the top of the Administration window to save the changes. A message appears asking if you want to change all existing computers to use the new default.
5. Click Yes to set all computers to the new defaults, or click No set the new default, but leave existing computers with their current authentication settings. NOTE: If you leave existing computers to “Network” authentication and you are using the Windows Peer to Peer network setting then the Client uses PIN code authentication instead.

To change the client authentication for a computer:

1. Click on the Advanced header on the left hand side of the Administration window. The left hand list switches to the advanced sections.
2. Click on the Network and Authentication button on the left hand side of the Administration window. The section appears with the list of computers that have printed.
3. Double-click on the computer that you want to change authentication for. The Computer window appears.
4. Use the Authentication drop down box to select the authentication type.
5. Click the Save button on the Computer window. The Computer window closes and the computer list refreshes to show the changes.

**To change the tools authentication:**

1. Click on the Advanced header on the left hand side of the Administration window. The left hand list switches to the advanced sections.
2. Click on the Network and Authentication button on the left hand side of the Administration window. The section appears with the list of computers that have printed.
3. Use the Tools authentication drop down to select the type of Tools Authentication you want.
4. Click the Save button on the toolbar at the top of the Administration window to save the changes.

**Network Login Authentication**

For advanced users Print Audit supports network login authentication. This allows you to have your users enter their Windows or Novell network login information before they print or use the Print Audit tools.

Using this setting on a Windows operating system has the issues that you need to be aware of:

- You cannot use this setting in combination with the "Windows Peer to Peer" Print Audit network type.
- Windows 95, 98, ME computers cannot authenticate with network settings unless they are configured to use user-level sharing. You need to change this in the network settings of your Windows 9x based operating systems.
- If you have NT based computers that are not on the domain they may not be able to successfully authenticate. This is because they authenticate to their local user database and report the domain as the computer name.

For these reasons we recommend you only use this setting if you are running a Novell network or if your Windows network consists of Windows NT based operating systems that connect/authenticate to a domain. If you have a mixed environment we recommend using PIN code security instead.
Print Audit 5 Job Manager

Welcome

Welcome to the Print Audit 5 Job Manager. You use this tool to manage your detailed print job information.

You can search for jobs using several different pieces of search criteria. Once you find the jobs you want you can edit the jobs, build reports based on the job details and export the job information.

You can also use the Job Manager to schedule exports of your job information to a file format that your accounting program can read.

For users upgrading from Print Audit 4, the Job Manager provides functionality similar to the Print Audit 4 Viewer.

Finding, Viewing and Editing Jobs

Print Job Window

This window allows you to view and edit a print job. Please note that not all of these fields are editable. Please see the details below.
Summary Tab

This tab contains a summary of information about the printed job.

- **User** - The name of the user who printed the job. Not editable.
- **Printer** - The name of the printer that printed the job. Not editable.
- **Document** - The name of the document that was printed.
- **Date Printed** - The date and time the document was printed.
- **Pages** - The number of pages in the job. This does not take into account copies, duplexing or pages per sheet printing. Changing this can change the total cost of the job.
- **Copies** - The number of copies in the job. Changing this can change the total cost of the job.
- **Color** - If checked, the job was in color. Changing this can change the total cost of the job.
- **Duplex** - If checked, the job was printed in duplex mode. Changing this can change the total cost of the job.
- **Pages per Sheet** - The number of "logical" pages per physical sheet of paper when printed. Also known as "n-up" printing. Changing this can change the total cost of the job.
- **Count as sheets not pages** - Check this to calculate the total number of pages based on the total number of sheets used. This setting changes the total pages calculation to take into account duplex printing as well as "pages per sheet" printing. Changing this can change the total cost of the job.
- **Comments** - General comments entered on the Client Popup Window when this job was printed.

Custom Tab

This tab contains any/all custom field entries made when the job was printed. This tab is available only if you purchased the Recovery feature of Print Audit 5.

**Custom Value** - Print Audit lists one custom value for each custom field used when the job was printed. Changing these values can change the total cost of the job.

Costs Tab

This tab contains a breakdown of costs associated with the job when printed.

- **Price Option** - The pricing option used when the job was printed. Changing this can change the total cost of the job.
- **Cost Per Unit** - This is the cost per unit used for the job taking into account all modifiers. You can only change this cost directly if you
check the **Override** box to the right. Checking **Override** ignores all modifiers and uses the cost you enter.

- **Added Costs** - These are the added costs for the job taking into account all modifiers. You can only change this cost directly if you check the **Override** box to the right. Checking **Override** ignores all modifiers and uses the cost you enter.
- **Cost Modifiers List** - This list contains all of the cost modifiers used for this job. You can change any individual modifier by editing it directly in the list.

**Miscellaneous Tab**

This tab contains general information about the job.

- **Job type** - The type of job. This job type ties in directly with the job type accounting codes. Change this type to what you want the job reported as for accounting purposes.
- **Job from** - Where the job originated. Strictly for informational purposes.
- **Computer** - The computer from where the job originated. Not editable.
- **Process** - The program that printed the job. Not editable.
- **Paper Size** - The paper size name reported by the driver. Print Audit may also set this paper size if the job was tracked as "per paper size". Not editable.
- **Page Width and Height** - The width and height of the page printed. Not editable.
- **Printed to File** - If checked, Print Audit detected that this job was printed to file, not directly to the printer. Not editable.

**Technical Tab**

This tab contains technical information about the job related to the driver used and how the job was tracked.

- **Operating system** - This contains the operating system that generated the print job. Not editable.
- **Driver name** - The print driver name used to generate the job.
- **Driver version** - The version of the driver used to generate the job.
- **Tracked As** - How the job was initially tracked, with or without the Client Popup window.
- **Popped Early** - If checked, the Client Popup window was set to appear immediately, otherwise was set to appear after the job spooled.
Searching for Print Jobs

One of the first steps in using the Job Manager is to find the job or jobs you want to act on. Print Audit allows you to search for jobs based on a combination of criteria.

We highly recommend that you narrow your search as much as possible. Print Audit can track thousands of print jobs per day depending on the printing volumes in your organization.

You can search for jobs based on the following:

- **Date Printed** - You can specify the date range in which the jobs you want were printed. You can select from one of the standard date ranges, or select **Custom** from the drop-down to enter your own custom date. Print Audit always uses a date range for the search.

- **User who printed** - Use the drop down to select the user you want to search on. You can also type the first few characters of the user name to have Print Audit find all matching users. Click the **Match on Reporting group** option to have Print Audit match on a reporting group you select rather than a user name. You assign users to reporting groups with the Administration tool. If you leave this blank, Print Audit finds jobs for all users. Please note that you can only select users if you have access to view all print job data.

- **Printer used** - Use the drop down to select the printer you want to search on. You can also type the first few characters of the printer name to have Print Audit find all matching printers. Click the **Match on Reporting group** option to have Print Audit match on a reporting group you select rather than a printer name. You assign printers to reporting groups with the Administration tool. If you leave this blank, Print Audit finds jobs for all printers.

- **Custom Fields (Recovery only)** - If you have defined custom fields to display on the Client Popup window, then you can search on specific custom field values for each custom field you defined.

To search for print jobs:

1. Enter your criteria as described above.
2. Click the **Find Jobs** button on the toolbar. A list of all matching jobs displays in a list below the search criteria.

Changing Your Data View

The Print Audit Job Manager allows you to configure the way you view the columns of information in the job results lists. You can show and hide...
individual columns, re-arrange the columns and sort on the column information.

Once you get the columns arranged to suit your needs, you can save the configuration and give it a name. You can create multiple configurations this way and easily switch between them.

Please note that you must have searched for and found jobs before you can adjust a view.

**To show and hide columns**

1. Right-click on any column header. The **Columns in View** window appears.
2. Check the box to the left of a column name to display the column, or clear the check box to hide the column.
3. Click the **OK** button once you have the arrangement you want. The **Columns in View** window closes and the list updates.

**To re-size a column**

1. Move the mouse cursor until it is on the right-hand edge of the column header for the column you want to resize. The cursor changes to resize mode.
2. Click and hold the left mouse button and drag the column edge to the left to make the column smaller or to the right to make it larger.
3. Release the mouse button once column is the size you want. The column resizes to the new size.

**To re-size all columns to fit**

Click the **Edit->Size Columns To Fit** menu item. Print Audit resizes all displayed columns to fit the data displayed in the columns. Please note that this can take several seconds depending on the number of jobs in the list.

**To move a column**

1. Click and hold the left mouse button on the column header of the column you want to move.
2. Move the mouse right to move the column to the right, left to move the column to the left. You should see an outline showing you where the column will end up.
3. Release the mouse button once the column is in the position you want. The column moves to the new position.
To sort on a column

Click on the column header of the column you want to sort. An arrow appears in the column header indicating the sort order. Click again to change the sort order.

To save your data view

1. Click the **Save Data View** button on the toolbar. A dialog appears asking you to enter the name of the new view.
2. Enter the name you want to call the view.
3. Click the **OK** button on the dialog. The dialog closes and the new view appears in the **Views** drop down in the toolbar. Please note that if you enter the same name as an already existing view Print Audit overwrites the old view.

To select a previously saved data view

1. Click on the **Views** drop down in the toolbar. A list of all previously saved views appears.
2. Click on the view you want. The results view changes to the new view.

To delete a previously saved data view

1. Select the data view you want to delete as described in the previous section.
2. Click the **Delete View** button on the toolbar. Print Audit deletes the view and switches to the default view.

**Editing and Deleting Jobs**

New to Print Audit 5 is the ability to edit existing print jobs. Once you print a job you may want to adjust the job costs, view the detailed job information or delete the jobs.

You can control who has permission to edit and delete jobs.

**To edit/view a print job**

1. Search for the job you want to edit.
2. Double-click on the job you want to edit. The **Print Job Window** appears.
3. Make changes to the job if appropriate. Please note that not all fields are editable.
4. Click the **Save** button to exit and save any changes or click the **Cancel** button to close the window.

**To delete individual print jobs**

1. Search for the job you want to delete.
2. Click on the job you want to delete. The job highlights.
3. Click the **Delete Current Job** on the toolbar to delete the highlighted job. A dialog appears asking if you are sure you want to delete the job.
4. Click **Yes** to delete the job from the database. The list refreshes to show the results.

**To delete an entire list of jobs**

1. Search for the jobs you want to delete.
2. Click the **Edit->Delete All Jobs in List** menu item. A dialog appears asking you to confirm that you want to delete all the jobs in the list.
3. Click **Yes** to delete all the jobs in the list.

**Job Reporting**

**Job Manager Reports**

The Print Audit 5 Job Manager allows you to quickly build custom reports based on the jobs in your database. Once you design a report you like you can save the report definition so you can easily create it again.

You can only create reports that deal with the specifics of your print job information. For reports designed for in-depth analysis of your printing information you can use the Print Audit Analysis Reporting tool.

You can use the Job Manager to create three types of reports:

- **Summary Report** - This report allows you to report on total job costs and volumes.
- **Full Report** - This report allows you to report detailed information along with a breakdown of total job costs and volumes.
- **Detail Report** - This report allows you to report detailed print job information in a sorted format but with no totalling.

Once you create the report you want it displays in its own tab in the Job Manager window. You can then print it to a printer or export it to PDF or HTML formats.

After you are done viewing, printing or exporting your report you can click on the **Remove Report** button on the toolbar to close it.
Creating Reports

Please follow the steps below to quickly create reports based on your print jobs.

To create a Summary report:

1. Search for the jobs you want to include on the report.
2. Click the Create a new Report button on the toolbar. The Build a Report wizard appears.
3. Click on Summary (Totals Only) in the reports list on the left. A description of the report appears on the right.
4. Click the Next button. The wizard changes to the Total By tab.
5. Select the columns to total on. You can select up to three column to total on. For example, you could select User, Printer and Color to get totals for each user broken down by printer and color.
6. Select the unit type you want to display for the unit totals.
7. Check the Show job cost totals to display cost totals on the report, broken down by your Total By selection.
8. Check the Show job count totals to display the total number of jobs on the report, broken down by your Total By selection.
9. Click the Next button. The wizard changes to the Titles tab.
10. Enter in an optional title and sub-title you want displayed at the top of each page in the report.
11. Click the Build button to build and display the report. If you want to keep this report definition to re-run later, you can click Save and Build to enter a name and description for your new report definition. If you save a report definition it displays in the list of available reports the next time you run the Build a Report wizard.

To create a Full report:

1. Search for the jobs you want to include on the report.
2. Click the Create a new Report button on the toolbar. The Build a Report wizard appears.
3. Click on Full (Details and Totals) in the reports list on the left. A description of the report appears on the right.
4. Click the Next button. The wizard changes to the Fields tab.
5. Select up to five fields to display in the report. These fields appear as columns on the finished report.
6. Click the Next button. The wizard changes to the Total By tab.
7. Select the columns to total on. You can select up to three column to total on. For example, you could select User, Printer and Color to get totals for each user broken down by printer and color.
8. Select the unit type you want to display for the unit totals.
9. Check the **Show job cost totals** to display cost totals on the report, broken down by your **Total By** selection.
10. Check the **Show job count totals** to display the total number of jobs on the report, broken down by your **Total By** selection.
11. Click the **Next** button. The wizard changes to the **Titles** tab.
12. Enter in an optional title and sub-title you want displayed at the top of each page in the report.
13. Click the **Build** button to build and display the report. If you want to keep this report definition to re-run later, you can click **Save and Build** to enter a name and description for your new report definition. If you save a report definition it displays in the list of available reports the next time you run the **Build a Report** wizard.

**To create a Full report:**

1. Search for the jobs you want to include on the report.
2. Click the **Create a new Report** button on the toolbar. The **Build a Report** wizard appears.
3. Click on **Details Only** in the reports list on the left. A description of the report appears on the right.
4. Click the **Next** button. The wizard changes to the **Fields** tab.
5. Select up to five fields to display in the report. These fields appear as columns on the finished report.
6. Click the **Next** button. The wizard changes to the **Sort By** tab.
7. Select the columns to sort. You can select up to three column to sort by. Please note that you must have selected these columns on the **Fields** tab.
8. Click the **Next** button. The wizard changes to the **Titles** tab.
9. Enter in an optional title and sub-title you want displayed at the top of each page in the report.
10. Click the **Build** button to build and display the report. If you want to keep this report definition to re-run later, you can click **Save and Build** to enter a name and description for your new report definition. If you save a report definition it displays in the list of available reports the next time you run the **Build a Report** wizard.

**Printing and Exporting Reports**

Once you create a report you can either print the report or export it to a different file format. Please follow the steps below to print and export your reports.
To print a report:

1. Create the report you want. If already created, click on the tab containing the report you want to print.
2. Click the **Print Report** button on the toolbar. A dialog appears asking you to select your printer.
3. Select the printer and click the **Print** button. The dialog closes and Print Audit sends your report to the printer.

To export a report:

1. Create the report you want. If already created, click on the tab containing the report you want to print.
2. Click the **Export Report** button on the toolbar. A dialog appears asking you to select the export type and the file name.
3. Use the **Save as type** drop down box on the dialog to select the export type. You can select from PDF and HTML formats.
4. Click the **Save** button. Print Audit saves the report to the file you specified.

How to Create a Billing Statement

To create a billing statement style report in the Job Manager you first need to search for the jobs you want to bill for, and then generate the report. This example leads you through creating a detailed billing statement for the previous month. The example also assumes that you have a custom field called "Client" that contains codes used that correspond to the client you are billing. See detailed steps below.

1. Open the Print Audit 5 Job Manager.
2. Use the **Date Printed** drop-down box to select a date range for the jobs you want to bill for. For this example select "Last Month" from the drop-down.
3. You can choose to narrow down the report to one specific "Client" or all clients in the database. If you want to narrow down the client select the appropriate one from the **Client** drop-down. Please remember that we are assuming you have a "Client" custom field defined for this example, you can choose to narrow down the search based on any custom field you define.
4. Click the **Find Jobs** button on the toolbar. A list of jobs that match your search criteria appear.
5. Click on the **Create Report** button on the toolbar. The Build a Report wizard appears.
6. Select the level of detail you want in the report. Since we want to produce a detailed billing statement, click the "Full (Details and Totals" option.
7. Click the Next button. The wizard moves to the Fields tab.
8. Double-click the fields in the left hand list you want to include on the report. They move to the right hand side. For this example include Document name, Date Printed, Total Units and Total Cost.
9. Click the Next button. The wizard moves to the Total By tab.
10. Use the 1st choice, 2nd choice and 3rd choice drop down boxes to select fields you want to total on. For this example select your "Client" custom field for the first choice and "Color" for your second choice. Leave the third choice blank. This will calculate totals on the report for each client and further break it down by color vs black and white jobs.
11. Use the Unit Totals drop down to select "Pages". This will show all totals in pages.
12. Check the Show job cost totals box to display a sub-total of job costs for each client.
13. Click the Next button. The wizard moves to the Titles tab.
14. Enter in an appropriate title and sub-title. For this example a title of "Monthly Billing Statement" may be appropriate.
15. Click the Build or the Build and Save button. Both will build the report, but Build and Save also saves this report definition so that you can re-run the exact report any time you want. Once Print Audit builds the report it appears in a tab in the main Job Manager window.
16. Use the Print Report button on the toolbar to print your new report or Export Report button to save the report in different formats.

Job Exporting

Custom Export Configurations

Print Audit job exporters allow you to create and save several different export configurations. This gives you great flexibility in how your data exports.

Every time you export your current results or your accounting information you can select from any one of your saved export configurations.

Currently Print Audit supports Flat File exports. These are very similar to the job exporting functionality supported in the Print Audit 4 Viewer.

To view and create export configurations:

1. Search for the jobs you want to export.
2. Click the Tools->Export Results menu item. The Export Jobs window appears.
3. Select the export type for which you want to view configurations. Currently Print Audit supports Flat File exports.
4. Click the Configurations button. The Export Configurations edit window appears.
5. Use the Configuration drop down to select the configuration you want to edit.
6. Make the changes as appropriate.
7. Click the Save As button to create a new configuration based on the changes made OR click the Save button to save the changes to the existing configuration.
8. Click the Close button to close the configurations window.

Exporting Your Current Results

This export type allows you to export all jobs in your current results list to an export type you specify.

To export your results:
1. Search for the jobs you want to export.
2. Click the Tools->Export Results menu item. The Export Jobs window appears.
3. Select the type of export you want to do from the Export type drop down box. Currently your options may only include a Flat File Export. New types of exports may be available in the future.
4. Select the configuration you want from the Configuration drop down. If you have not defined a custom configuration you only have the <Default> configuration.
5. Click the Export button to export your information. Depending on your export configuration you may have to select a file name or enter other information. Once done Print Audit exports your jobs.

Exporting for Accounting

The Job Manager allows you to export jobs for accounting purposes. This differs from standard exporting in that once you export jobs for accounting they are marked so that Print Audit does not export them for accounting again. You can then be sure that when you run accounting the next time, only those jobs that were not accounted for previously are exported.

You can also schedule accounting runs. Print Audit integrates with the Microsoft Windows Task Scheduler to allow you to automatically run
accounting daily, weekly or monthly. You can combine this with a scheduled task for your accounting program to completely automate your accounting process.

When you export for accounting from the Job Manager it takes all jobs that have not been accounted regardless of any other search criteria or job results that may be displayed in the Job Manager.

Exporting the Current View

This export type allows you to quickly export the jobs you searched for to a comma-delimited file. The comma-delimited file stores only the job columns showing in your current data view. It also stores the columns in the same order as they are in the data view.

To export your jobs:

1. Search for the jobs you want to export.
2. Select the view for how you want your data displayed and exported.
3. Click the Tools->Export View menu item. A dialog appears asking you for the comma-delimited file name.
4. Select or enter the file name you want to export to.
5. Click the Save button on the dialog. The dialog closes and Print Audit starts exporting the jobs.

Flat File Export Configuration Window

This window allows you to created, modify and delete export configurations. These configurations are then used to format data for exporting. For more information on exporting, see Exporting Jobs.

- **Configuration** – Use this drop down box to select the configuration you want to edit. The list is the list of all configurations you previously created.
- **Save As Button** – Use this button to create a copy of the currently selected configuration.
- **Delete Button** – Use this button to delete the currently selected configuration.
- **Output File** – This field contains the path and name of the file you want the export to go to. If you leave this blank, Print Audit asks for the file name every time you export.
- **File Browse Button** – Click this button to open a standard Windows save dialog box. Use this box to choose the path and enter the name of the output file.
- **Save Button** – Click this button to save the changes to the current configuration.
- **Close Button** – Close the Export Configurations window.

**Options Tab**

- **Delimited Option** – Click this option to have the export use a delimiter that you define to separate fields in a row of output. The most common type of delimiter is a comma. Most programs can import comma-delimited files.
- **Fixed Width Option** – Click this option to have the export use a fixed width for each column to separate the fields in a row of output. For example, for a fixed width export you can set a column to be 10 characters. Even if there are only 5 characters in the data, the field will be padded out to 10 characters.
- **Field Delimiter (Delimited Only)** – This field contains the character you want to use to delimit the fields. Some common values are commas, pipe characters and tab character. To use the tab character you must enter the text “<TAB>” (without the quotation marks). This is the only special value, Print Audit interprets every other value exactly.
- **Add on Row Start (Delimited Only)** – If checked, this tells Print Audit to add a field delimiter at the start of a row. For example if you use a comma as a delimiter, a row containing two values would look like this “,1,2”.
- **Add on Row End (Delimited Only)** – If checked, this tells Print Audit to add a field delimiter at the end of a row. For example if you use a comma as a delimiter, a row containing two values could look like this “1,2,”.
- **Enclose Strings in Quotes (Delimited Only)** – If checked, this tells print audit to put all strings in quotation marks. This is particularly important if you are using a comma as a delimiter, but some of the text fields have commas as well. That would cause the program you are using to import to behave incorrectly.
- **Output Column Name Row (Delimited Only)** – If checked, the first row that Print Audit exports is a row of names for all of the columns you are exporting.
- **RowDelimiter Type** – Use this drop down box to select the end of row delimiter. The most common type of row delimiter is a combination of a Carriage Return character and a Linefeed Character. If you choose Custom, then you can delimit the row with any type of character.
• **Append to Existing File** – If checked and the named output file exists, this tells Print Audit to append the data to the end of the file. If cleared, Print Audit overwrites any existing data in the file.

• **Date Format** – This field allows you to define a custom date format for any dates in the export. The date format follows the VBA date formatting characters. In general, M – month, d – day, y – year. For more information on date formats, see Date Formats.

• **Date Format Preview Button** - Click this button to preview how your entered date format will affect the date.

**Columns Tab**

• **Totals Only** – If checked, this tells Print Audit to run totals based on the column selected to the right. This creates a file consisting only of the total for each job. If clear, no totals are calculated and all the detail rows are exported.

• **Totals Field** – Use this dropdown to select the field you want to total on. Only valid if Totals Only is checked.

• **Name Column** – This contains the name of the data column to export in this position. Click on the cell to enable a dropdown combo which you can use to select a different data column. You can also type free form text into this cell. If you do, that text appears in every row in the export.

• **Width Column (Fixed Width Only)** – In a fixed width export, this cell contains the number of characters for this data column.

• **Right Justify Column (Fixed Width Only)** – If checked, this puts a pads the data column on the left, otherwise it pads on the right.

• **Pad Char Column (Fixed Width Only)** – In this column you can specify the pad character to use when padding the fixed width column. Generally this is a space character.

• **Add Column Button** – Click this button to add a blank row to the export columns grid. You can then click in this row to select a data column and enter the other pertinent information.

• **Remove Column Button** – Click this button to remove the currently selected row from the export columns grid.

• **Move Up Button** – Click this button to move the selected row up in the list. The order of the rows indicate the left-right order of the data columns in the export.

• **Move Down Button** – Click this button to move the selected row down in the list. The order of the rows indicate the left-right order of the data columns in the export.
Flat File Export Date Formats

This topic describes the format characters you can use when defining date formats for exporting data. These characters are exactly the same as you would use for standard VBA date formatting. A subset of these characters appears below.

M – Month, 1 digit. For example, the month of March would appear as 3.

MM – Month, 2 digit. For example, the month of March would appear as 03.

MMM – Month, abbreviation. For example, the month of March would appear as Mar.

MMMM – Month, full. For example, the month of March would appear as March.

d – Day. Follows the same rules as the M character. You can have d, dd, ddd, dddd.

y – Year character. You would use yy for a two digit year or yyyy for a full four digit year.

h – Hour character. Use hh for a two digit hour.

m – Minute character. Use mm for a two digit minutes.

s – Second character. Use ss for a two digit seconds.

AM/PM – Use this combination to indicate you want to use a twelve hour clock. Otherwise a 24 hour clock is assumed.

Other characters will appear as themselves.

Here are some examples how date formats would affect January 15, 2001 at 10:30 PM:

MM/dd/yy hh:mm:ss would appear as 01/15/01 22:30:00.

MMM dd, yyyy would appear as Jan 15, 2001

dddd, MMMM dd yyyy h:mm AM/PM would appear as Monday, January 15, 2001 10:30 PM.
Exporting Jobs

The Job Manager allows you to export your print jobs to several different formats. You can then use this file in third-party accounting or reporting tools to give you even more job processing options. For example, you could export your jobs to a standard comma-delimited format to allow you to open the jobs in Microsoft Excel for detailed analysis.

When you export jobs you generally need to select an export type and an export configuration. The export type determines how Print Audit will export the jobs. For example, the Flat File export type exports your information to a standard text file.

The export configuration determines the format and options of the export type. For example you could create a Flat File export that only exports five columns of data in a tab-delimited format.

You can export jobs in one of three ways. Click on the links below for more information:

- **Export Current Results** - This allows you to choose the export type and configuration you want to use to export all jobs in your current results list.
- **Export Current View** - This allows you to quickly export all jobs in your current results list to a comma-delimited file that mirrors how you have constructed your current data view.
- **Run Accounting** - This allows you to choose the export type and configuration you want to use to export all jobs in your database if they have not already been exported for accounting. This export type does not take into account any of your job search criteria.

Print Audit currently supports only Flat File exports.

Accounting

Job Type Account Codes

Print Audit 5 allows you to define custom account codes for different job/transaction types. For example you could assign a different accounting code to Print jobs versus Copy jobs.

You can then choose to export these account codes with your other job information to make integration into your accounting data easier.
To setup transaction codes:

1. Click the Accounting->Edit Job Type Account Codes menu item. The Edit Job Type Account Codes window appears.
2. Click in the Code column for the job type you want to change.
3. Type the new account code in the column.
4. Repeat 2-3 to change codes for all the transaction types.
5. Click the Save button. The Edit Job Type Account Codes window closes.

Running Accounting Exports

This export type allows you to export any non-accounted jobs to an export type you specify.

To export for accounting:

1. Click the Accounting->Run Accounting menu item. The Export Jobs window appears.
2. Select the type of export you want to do from the Export type drop down box. Currently your options may only include a Flat File Export. New types of exports may be available in the future.
3. Select the configuration you want from the Configuration drop down. If you have not defined a custom configuration you only have the <Default> configuration.
4. Click the Export button to export your information. Depending on your export configuration you may have to select a file name or enter other information. Once done Print Audit exports your jobs for accounting.
You can also have Print Audit run an export on a scheduled basis. You may also need to re-do accounting runs.

Clearing Accounting Runs

In some cases you may need to clear previous accounting runs. For example a file could get lost, or some error could occur with your accounting system that requires you to re-export jobs for accounting. The Job Manager allows you to clear any accounting run.

To clear an accounting run:

1. Click the Accounting->Accounting Runs menu item. The Clear Accounting Runs window appears.
2. Click on the accounting run you want to clear in the list.
3. Click the **Clear** button. A dialog displays asking you if you are sure you want to clear the run.
4. Click the **Yes** button. Print Audit marks all the jobs in the run as ready to export. The next time you run accounting all jobs that were in the cleared run will export.

### Scheduling Accounting Exports

Using the Job Manager you can schedule accounting exports to run daily, weekly or monthly. You can use this functionality to automate the importing of your print job information into an accounting system.

Print Audit integrates with the Microsoft Windows Task Scheduler. Advanced users can use the task scheduler directly to further customize how the export runs.

**IMPORTANT:** Before you can schedule an accounting run you must create a Print Audit user with rights to run accounting and assign them a PIN code.

**To schedule an accounting export:**

1. Click the **Accounting->Run Accounting** menu item. The **Export Jobs** window appears.
2. Select the type of export you want to do from the **Export type** drop down box. Currently your options may only include a Flat File Export. New types of exports may be available in the future.
3. Select the configuration you want from the **Configuration** drop down. If you have not defined a custom configuration you only have the `<Default>` configuration.
4. Use the **Run Export** drop down to select how often to run the export. Choices are Daily, Weekly or Monthly.
5. Use the **On** drop down to select the day on which to run the export. This is only effective for Weekly or Monthly schedules.
6. Use the **At** selector to select the time of day at which to run the export. We recommend using a time outside of regular business hours.
7. Click the **Schedule** button. The **Accounting Run PIN Code** window appears.
8. Enter the Print Audit PIN code of someone authorized to export all job information.
9. Click the **OK** button. If the PIN code is valid Print Audit stores the settings you entered and creates the task.
To un-schedule an accounting export:

1. Click the Accounting->Run Accounting menu item. The Export Jobs window appears.
2. Select the type of export you want to do from the Export type drop down box. Currently your options may only include a Flat File Export. New types of exports may be available in the future.
3. Select the configuration you want to remove from the Configuration drop down.
4. Click the Unschedule button to remove the task.

You can also use the Windows Task Scheduler interface directly to remove scheduled runs.

Advanced

Job Manager and Merged Jobs

You can use the Job Manager to view jobs from a merged Print Audit database. Print Audit 5 allows you to merge jobs from multiple companies into one database. For more information on how to merge jobs, please see the documentation on the Print Audit Job Merge Wizard.

If you have jobs from multiple companies in the database you can choose to view any one of the company's data or view all companies at once.

To change the company:
- Click the Company drop down in the toolbar. A list of all available companies appears.
- Select the company you want to view. The Job Manager clears any existing job results and any reports.
- Search for the jobs you want for the new selection.

NOTE: When exporting for accounting, Print Audit exports jobs from ALL companies regardless of any company selection in the Job Manager.

Securing the Job Manager

Print Audit allows you to define several different levels of security for the Job Manager. You can also choose to have users enter a PIN code or their network login information before they can use the Job Manager.
Before you can schedule accounting exports you must enter the PIN code of a user who has the rights to run accounting. Print Audit needs this to ensure that your job information is secure as possible. You can choose to enter a PIN code of an existing user or use the Administration tool to create a new user that has run accounting rights.

All security settings in Print Audit are controlled through the Print Audit 5 Administration tool. Please see the topics on Security Profiles and Authentication in the Administration help for more information on security.

Here is a list of the policies you can set in the Security Profile that affect the Job Manager:

- **User can view their own print job data** - A user with this policy can view, export and print only their print job information.
- **User can view all print job data** - A user with this policy can view, export and print all print job information.
- **User can edit existing print jobs** - A user with this policy can edit jobs in the Job Manager.
- **User can run accounting** - A user with this policy can run and clear accounting exports.

If a user does not have any of these policies in their security profile then they cannot use the Print Audit Job Manager.

**Print Audit 5 Analysis Reporting**

**Overview**
Welcome to Print Audit Analysis Reporting. You can use this tool to produce pre-prepared reports for your printing volumes and costs. You can use these reports to determine your highest volume printers, distribution of job sizes, percentage of color vs. black and white printing, etc.

Understanding the Analysis Reporting Tool

The Print Audit Analysis Reporting tool consists of two main areas, the toolbar and the tabbed display area. You use the toolbar to manipulate tabbed information or even create new tabs. The tabs themselves display your printer and user groups along with any created reports.

There are only two tabs visible when you first run the Analysis Reporting tool. They are the **Printer Grouping and Filtering** tab and the **User Grouping and Filtering** tab.

The **Printer Grouping and Filtering** tab displays all printers in your Print Audit database. You use this tab to arrange printers into reporting groups as well as selecting which printers/groups you want to include in your reports. You can also use this tab to enter an estimated cost per page for the printer. Generally, Print Audit uses the actual recorded cost of the print job to calculate total costs when you are doing reports. If you choose, you can have Print Audit use the estimated cost per page you enter to calculate costs. IMPORTANT: Actual costs in Print Audit include several things such as unit type, cost modifiers, etc. Estimated cost per page only takes into account the reported page count.

The **User Grouping and Filtering** tab displays all users in your Print Audit database. You can use this tab to group your users any way that makes sense for your organization. You could group them by last name, or by department, etc.

Once you have your groups defined you can create reports based on your data. After you create a report you can then print it or export it in different formats.
Grouping and Filtering

Grouping Information

The Print Audit Reporting Analysis tool allows you to group your printer and user information together. Grouping information has two main purposes:

- Grouping allows you to organize your printers and users in ways that make sense for your organization.
- Grouping allows you to focus on high level reporting issues rather than individual printers.

The last point is the most important. The main function of grouping is to allow you to create groups that you can display on different reports. For example, you may have several printers on one floor of your office. You can combine those printers into a group called "4th floor" and generate reports based only on those printers.

You could also create user groups so you can report on printing costs based on internal departments.

To create a group:

1. Expand the <INDIVIDUAL> group or another group you have created to view the contents.
2. Click on one or more items to select them. You can use CTRL-click to select multiple individual items or use SHIFT-click to select a range of items. You can select items from more than one group at once.
3. Click the Create/Add to Group button on the tool bar. The Create/Add to Group window appears.
4. Select the option to either create a new group or move the selected items to an existing group.
5. Enter your new group name or select the existing group.
6. Click the OK button. This moves the selected items to the group you specified.

To delete a group:

1. Click on the group you want to delete. You cannot delete the <INDIVIDUAL> group.
2. Click the Delete Group button on the toolbar. A message box appears asking if you are sure you want to delete the group.
3. Click Yes on the message box. The Analysis tool removes the group and moves any items in that group to the <INDIVIDUAL> group.

To rename a group:

1. Click on the group you want to rename. You cannot rename the <INDIVIDUAL> group.
2. Click in the column that contains the name of the group. This is the Printer column for the Printer Information tab, the Name column for the User Information tab.
3. Type the name of the new group.

Using the Printer Grouping and Filtering Tab

This tab shows all of the printers in the Print Audit database. You use this tab to decide whether or not printers or groups of printers are included in reports.

To view the contents of a printer group:

Click the "plus/minus sign" at the left of the group name to expand/collapse the group. When expanded you can see all of the unique printers included in the group.

To group printers:

1. Expand the <INDIVIDUAL> group or another group you have created to view the contents.
2. Click on one or more printers to select them. You can use CTRL-click to select multiple individual printers or use SHIFT-click to select a range of printers. You can select printers from more than one group at once.
3. Click the Create/Add to Group button on the tool bar. The Create/Add to Group window appears.
4. Select the option to either create a new group or move the selected printers to an existing group.
5. Enter your new group name or select the existing group.
6. Click the OK button. This moves the selected printers to the group you specified.

To include/exclude printers and groups from reports:

1. Expand the <INDIVIDUAL> group or another group you have created to view the contents.
2. Select the users or groups of printers you want to include/exclude.
3. Click on the Include column or hit the SPACEBAR key to toggle the selection.

Printer Grouping and Filtering Tab Columns

- **Include** – This column indicates whether or not you want to include the printer or printer group in any reports.
- **Printer** – This column contains the name of the printer or printer group.
- **Host** – This column contains the host computer for the printer. The host is the computer which controls the printer.
• **Port** – This column contains the port of the printer. For groups this is blank.

• **Est. Cost Per Page** - This column contains an estimated cost per page for the individual printer or group. Print Audit uses this estimated cost when you create estimated cost reports.

• **Connection** - How the printer is connected to the computer/network.

• **Model** – The model name of the printer.

• **Color** - Whether or not the printer supports color printing.

• **Duplex** - Whether or not the printer supports duplex printing.

**Using the User Grouping and Filtering Tab**

This tab shows all users in the Print Audit database. You use this tab to decide whether or not users or groups of users are included in reports.

**To view the contents of a user group:**

Click the "plus/minus sign" at the left of the group name to expand/collapse the group. When expanded you can see all of the unique users included in the group.

**To group users:**

1. Expand the `<INDIVIDUAL>` group or another group you have created to view the contents.
2. Click on one or more users to select them. You can use CTRL-click to select multiple individual users or use SHIFT-click to select a range of users. You can select users from more than one group at once.
3. Click the **Create/Add to Group** button on the tool bar. The **Create/Add to Group** window appears.
4. Select the option to either create a new group or move the selected users to an existing group.
5. Enter your new group name or select the existing group.
6. Click the **OK** button. This moves the selected users to the group you specified.

**To include/exclude users and groups from reports:**

1. Expand the `<INDIVIDUAL>` group or another group you have created to view the contents.
2. Select the users or groups of users you want to include/exclude.
3. Click on the **Include** column or hit the SPACEBAR key to toggle the selection.

**User Grouping and Filtering Tab Columns**
• **Include** – This column indicates whether or not you want to include the user or user group in any reports.
• **Name** – This column contains the name of the user or user group.
• **Domain** – This column contains the name of the domain the user belongs to.

**Saving and Loading Groups**

Once you have setup your groups for your printers and users you can choose to save them to a file so you can share them with others and to make sure you do not have to recreate them all again. You can also setup several different grouping schemes and load in whatever one you need for any given situation.

**To save your grouping information:**

1. Click the **Save Groups** button. A dialog appears asking you for the file name and path.
2. Use the dialog to choose where you want to save the group information file and choose a name.
3. Click the **Save** button on the dialog to save the groups.

**To load your grouping information:**

1. Click the **Open Groups** button. A dialog appears asking you for the location of the grouping file you want to load.
2. Use the dialog to find the grouping file you want to load.
3. Click the **Open** button on the dialog to load the groups into memory.

**NOTE:** Print Audit automatically saves the groups you were working with in the Analysis tool when you close it down. It saves them in a file called "lastused.grp" in your My Documents directory.
Reports

Creating and Removing Reports

The Reporting Analysis tool comes with several different reports for both user and printer reporting which help you to analyze the large amounts of data that Print Audit collects. Each report when it displays has an information cover page. This page is there to remind you of what you chose when you created the report. You can disable this feature at any time.

To create a report:

1. Create any groups you want for printers and users. Make sure to include only those groups you want on the report.
2. Click the Create Report button on the toolbar. The Create or Open a Print Audit 5 Report window appears.
3. Click on the Create a New Report button, or click on a previously saved report.
4. Click the Ok button. If you selected a previously saved report, the report displays in a new tab. If you chose to create a new report, the Create a Report Wizard appears. The rest of these steps assume you selected to create a new report.
5. Click on the type of the report you want in the reports list. The report highlights and a brief description of the report displays on the right.
6. Click the **Next** button to select your parameters. The Parameters tab appears.
7. Enter in the report parameters. There are several standard parameters, some reports have custom parameters.
8. Click the **Next** button to enter your report titles. The Titles tab appears.
9. Enter in any title and sub-title you want displayed on the report.
10. Click the **Build** button. The wizard closes and the new report displays in a tab in the main reporting window.

**To create and save a report:**

1. You can save reports that you build so you can use the same report again and again.
2. Follow steps 1-9 above.
3. Click the **Build and Save** button. A window appears asking you for a name and description you want to give to the report.
4. Enter in the name and description for the report.
5. Click the **Save** button. The window closes and your report appears in a tab in the main reporting window. It is also available to select the next time you create a report.

**To remove a report:**

1. Click the tab of the report you want to remove from the display.
2. Click the **Remove Report** button on the toolbar. A message box asks you if you are sure you want to remove the report.
3. Click the **Yes** button. Print Audit removes the report.

**To enable/disable information cover page:**

Click the **Reports->Create Cover Page** menu item. If checked, the cover page is printed, if not the cover page is not printed.

**Report Parameters**

When you create a report there are several standard options you can select. They are as follows:

- **Filter report data** - If checked Print Audit includes only those groups and individuals that you selected on the grouping tabs. If unchecked Print Audit includes all groups and individuals regardless of your selection.
- **Group report data** - If checked Print Audit uses the groups you selected on the grouping tabs to display information. If unchecked Print Audit does not use the groups and reports each user and printer individually.
- **Use Est. Costs** - Use the estimated costs instead of actual costs on the report. If checked Print Audit uses the estimated cost per page on the
Printer Grouping and Filtering tab to calculate costs instead of the costs recorded in the database. If disabled then the selected support does not allow you to use estimated costs.

- **Sorting** - You can choose to sort some reports in different orders. For example you can sort some reports by descending total page count. If disabled the report does not support custom sorting.

The **Parameters** section contains parameters that are specific to the report you selected. The most common parameter is the date range of the report. You can use the drop-down to select a standard date type or enter a complete custom date for the report.

**Printing and Exporting Reports**

Once you create the report you want you can choose to print it to your printer or export it to one of our supported formats.

**To print a report:**

1. Click on the tab of the report you want to print. If you have not created any reports, see **Creating and Removing Reports**.
2. Click the **Print Report** button on the toolbar. A dialog appears that allows you to select the printer.
3. Select the printer to which you want to print the report.
4. Click the **Print** button. The report will print to your printer.

**To export a report:**

1. Click on the tab of the report you want to export. If you have not created any reports, see **Creating and Removing Reports**.
2. Click the **Export Report** button on the toolbar. A dialog appears that allows you to select the export format and the path for the exported file.
3. Use the **Save as type** drop down box to select the type.
4. Use the dialog to select the directory where you want to export the file, and type the name.
5. Click the **Save** button. The analysis tool creates the report in the format you chose.

**Report Export Formats**

Print Audit supports several different formats to which you can export your reports. They are as follows:

- **Text File** – This exports the report to a flat text file. Columns are tab-delimited which can be imported into Excel.
• **HTML Page** – This exports the report to an HTML (web page) format you can then put on a website.

• **PDF File** – This exports the report to an Adobe PDF file format to send to others.

• **Raw Data** – This exports the underlying data of the report to a comma-delimited file. NOTE: The information exported may not correspond exactly to what you see in the report. For example, some totals and other calculations may not be in the data. This is due to the fact that some sub totaling and translation take place in the reporting engine.

---

**Print Audit 5 Job Merge Wizard**

Welcome to the Print Audit 5 Job Merge Wizard. You can use the Job Merge Wizard to copy job data from one Print Audit 5 database into another job database.
Job merging is a two step process. First you use the Job Merge Wizard to export the jobs from one database to a file on your computer. Then you can use the Job Merge Wizard to import that file into another database.

This capability is useful for deployments to large organizations with multiple sites. You can export job data from satellite sites, and imported it into a centralized database. This makes centralized reporting possible.

Requirements

To use the Job Merge Wizard the user must have Print Audit Administration rights. There are additional requirements to setup scheduled imports and scheduled exports:

- The Windows Scheduling Service must be running. This service is included as part of Windows98 and newer operating systems.
- You must have administrative privileges on the computer where the Wizard is being run.
- Before you can schedule job exporting and importing you must create a Print Audit user with Print Audit Administrator rights and assign them a PIN code. You are asked for this PIN code during the final step of the wizard.

Before You Begin

Merge Codes

Print Audit uses *merge codes* to allow you to import data from a large number of databases. The merge codes uniquely identify jobs and custom field values so you can keep track of where the merged data came from. You should decide on your merge codes before using the tool for the first time.

When exporting data from your database you need to enter an export merge code. You can choose any code you find easy to remember. You enter this code as the "Job Merge Code" when exporting data or setting up a scheduled export.

When importing the data (or setting up scheduled imports) you need to create a company that has the same merge code that was used when the data was exported. All the data imported with this merge code will be entered in the database under this company.
When exporting and importing custom field values you can specify a merge code for each field. The merge codes on the import side must match merge codes on the export side for everything to import correctly.

For example:
Suppose you have two offices using Print Audit. Your office is the "head" office. The other office is a "branch" office. You do not want to import custom fields. If you want to merge the branch office data into Print Audit you would need to do the following steps:

1. Choose a merge code for your branch office data. For this example use "branch001".
2. At the branch office, **export the data** using the Job Merge Wizard. Make sure to use the "branch001" code as the merge code.
3. Send the job file created in step 2 to the head office. You can send the file via email, ftp, WAN or any other way that makes sense for your organization.
4. At the head office, **import the data** using the Job Merge Wizard. Make sure you create a company with the "branch001" code on the Merge Codes tab of the import.
5. Import the data. All of the branch office data is now in the same database as the head office. You can use the Print Audit Job Manager and other tools to view and report on the data.

Performance

We recommend using SQL Server if importing jobs into your database. SQL Server can handle much larger volumes of data than Microsoft Access and can do so much more efficiently.

You can export from Microsoft Access and SQL Server, but if dealing with large volumes of data we highly recommend SQL Server.

If you do not have SQL Server in your organization you can also use Microsoft's MSDE. Please go to Microsoft's website for more information on MSDE.

General Usage

The Job Merge Wizard user interface guides you through the process of importing or exporting Print Audit 5 job data. At the top of the window for each step in the wizard is a help note. This note gives you a brief description of the information you need to provide.
Immediately below the help reminder is a list of tabs. This list grows as you use the wizard and contains all the steps that you have already completed along with the current and next steps. At any time you can click on a tab to view its contents and change any of the information. Some changes can cause the list of tabs to change.

Each tab contains information you need to complete before you can proceed to the next step.

Along the bottom of window are four buttons. The back and next buttons move you to the previous and next step in the process, respectively. Once you complete the final step, you use the Finish button to complete the Wizard. At any time, you can click the Cancel button to exit the Wizard without completing it. If cancelled no data is imported or exported.

**Importing**

**Importing Job Data**

To import data, the Wizard guides you through the following 5 steps.

**Step 1: Start**

Select **Import Jobs Now** and click Next. The wizard moves to the Database tab.

**Step 2: Import Into Database**

Review the currently selected database. Print Audit imports the jobs into this database. If you want to import data into a different database, click Change Database. Once you are satisfied with your database selection, click Next. The wizard moves to the Import Settings tab.

**Step 3: Job Import Settings**

Choose **Import Jobs Only** to ignore any custom field values in the import file, or click **Import Jobs and Custom Fields** to import custom field information along with the job information. NOTE: For the custom fields to import correctly the merge codes for the custom fields in the import file MUST MATCH the merge codes for your custom fields.

Choose **Duplicate records overwrite existing records** to overwrite a job in your database if it exists in both the file and the database. Choose **Duplicate**
records are ignored if you want to ignore jobs that exist in both the file and the database.

Enter a company name to use for non-imported print jobs. This can simply be your company name, or something like "Head Office". This allows you to easily distinguish between imported jobs and those jobs Print Audit tracked directly to the database. In Step 4 you will set up company names for the data you are importing.

Once you have decided and made the appropriate selections, click Next. The wizard moves to the Merge Codes tab.

**Step 4: Merge Codes**

You use this tab to add or update the merge codes. The Job Wizard uses merge codes to properly match jobs with companies and to match custom fields.

At minimum you must set up a company and corresponding merge code. Double-click an empty row in the Companies grid, and enter in the name of the company and the merge code. The merge code you enter MUST MATCH the merge code used when the jobs you are importing were exported. The company name you enter displays when reporting on the data.

You can create as many companies as you need. Generally you need to create one company for each database you import data from. If you do regular imports of data from two other databases you need to set up two companies, each with a different merge code.

If you chose to import custom field values in the previous step you also need to set up merge codes for the custom fields at this time. Enter in merge codes for custom fields that you want to import data into. These merge codes must match merge codes specified for the custom fields when the data was exported.

Note that unlike job data, imported custom field data becomes a direct part of the database. New custom field values that were imported will show up as options for Print Audit 5 clients which report directly to this database.

Once you have provided the merge codes, click Next. The wizard moves to the Import From File tab.
Step 5: Import from File

Choose the file you wish to import data from. This file will normally have a .jbs extension. Choose the file and click Finish. Print Audit starts importing your data. Please note that this can take several minutes depending on the amount of data being imported.

Setting up Scheduled Imports

To set up scheduled imports, the wizard guides you through the following 5 steps. Please note that there are additional requirements to set scheduled imports and exports.

Step 1: Start

Select Setup Scheduled Import and click Next. The wizard moves to the Database tab.

Step 2: Import Into Database

Review the currently selected database. Print Audit imports the jobs into this database. If you want to import data into a different database, click Change Database. Once you are satisfied with your database selection, click Next. The wizard moves to the Import Settings tab.

Step 3: Job Import Settings

Choose Import Jobs Only to ignore any custom field values in the import file, or click Import Jobs and Custom Fields to import custom field information along with the job information. NOTE: For the custom fields to import correctly the merge codes for the custom fields in the import file MUST MATCH the merge codes for your custom fields.

Choose Duplicate records overwrite existing records to overwrite a job in your database if it exists in both the file and the database. Choose Duplicate records are ignored if you want to ignore jobs that exist in both the file and the database.

Enter a company name to use for non-imported print jobs. This can simply be your company name, or something like "Head Office". This allows you to easily distinguish between imported jobs and those jobs Print Audit tracked directly to the database. In Step 4 you will set up company names for the data you are importing.
Once you have decided and made the appropriate selections, click Next. The wizard moves to the Merge Codes tab.

**Step 4: Merge Codes**

You use this tab to add or update the merge codes. The Job Wizard uses merge codes to properly match jobs with companies and to match custom fields.

At minimum you must set up a company and corresponding merge code. Double-click an empty row in the Companies grid, and enter in the name of the company and the merge code. The merge code you enter MUST MATCH the merge code used when the jobs you are importing were exported. The company name you enter displays when reporting on the data.

You can create as many companies as you need. Generally you need to create one company for each database you import data from. If you do regular imports of data from two other databases you need to set up two companies, each with a different merge code.

If you chose to import custom field values in the previous step you also need to set up merge codes for the custom fields at this time. Enter in merge codes for custom fields that you want to import data into. These merge codes must match merge codes specified for the custom fields when the data was exported.

Note that unlike job data, imported custom field data becomes a direct part of the database. New custom field values that were imported will show up as options for Print Audit 5 clients which report directly to this database.

Once you have provided the merge codes, click Next. The wizard moves to the Scheduling tab.

**Step 5: Job Import Schedule**

Set up either a daily, weekly, or monthly import schedule using the controls at the top of the tab. Enter a Print Audit PIN code that has Print Audit Administration privileges. Finally select the directory that contains the files to import.

Every time the schedule executes Print Audit imports all newly exported data files. Files already imported are ignored. The schedule simply controls how often Print Audit checks the directory.
When you are satisfied with your schedule, click the Finish button. At this time Print Audit confirms your PIN code and saves the schedule. If your PIN code is incorrect, you will be prompted to change it.

**Exporting**

**Exporting Job Data**

To export data, the Wizard guides you through the following 5 steps.

**Step 1: Start**

Select **Export Jobs Now** and click Next. The wizard moves to the Database tab.

**Step 2: Export From Database**

Review the currently selected database. The Wizard exports the jobs from this database. If you want to export data from a different database, click Change Database. Once you are satisfied with your database selection click Next. The wizard moves to the Export Settings tab.

**Step 3: Job Export Settings**

Click **Export Jobs Only** to export only job data from the database or click **Export Jobs and Custom Fields** to export job and custom field information.

Click **Export New Jobs** to export jobs printed since the last time you exported jobs or click **Export All Jobs in Database** to export all of the jobs.

Once you have made your choices, click Next. The wizard moves to the Merge codes tab.

**Step 4: Merge Codes**

You use this tab to add or update the merge codes. The Job Wizard uses merge codes to properly match jobs with companies and to match custom fields.

You must specify a merge code for the jobs you export. When these jobs are exported this merge code matches to one entered on the import side.
If you are including custom field values in your export, set up merge codes for the custom fields you wish to export. Double click on the Custom Field Merge Codes grid to the right of the custom field name to enter in a merge code.

If you leave the merge code for a field blank, it will not be exported.

Once you enter the merge codes click Next. The wizard moves to the Export tab.

**Step 5: Export to File**

Choose a location and name for the file you are going to export to. The file normally has a .jbs extension. Once you have chosen a file, click Finish, and the data will be exported.

Once Print Audit creates the exported file you can move it and copy it like any other file. You can e-mail it to someone, upload it to an FTP site, or copy it to another computer on your network.

**Setting up Scheduled Exports**

To set up scheduled imports, the wizard guides you through the following 5 steps. Please note that there are additional requirements to set scheduled imports and exports.

**Step 1: Start**

Select **Setup Scheduled Exports** and click Next. The wizard moves to the Database tab.

**Step 2: Export From Database**

Review the currently selected database. The Wizard exports the jobs from this database. If you want to export data from a different database, click Change Database. Once you are satisfied with your database selection click Next. The wizard moves to the Export Settings tab.

**Step 3: Job Export Settings**

Click **Export Jobs Only** to export only job data from the database or click **Export Jobs and Custom Fields** to export job and custom field information.

Click **Export New Jobs** to export jobs printed since the last time you exported jobs or click **Export All Jobs in Database** to export all of the jobs.
Once you have made your choices, click Next. The wizard moves to the Merge codes tab.

**Step 4: Merge Codes**

You use this tab to add or update the merge codes. The Job Wizard uses merge codes to properly match jobs with companies and to match custom fields.

You must specify a merge code for the jobs you export. When these jobs are exported this merge code matches to one entered on the import side.

If you are including custom field values in your export, set up merge codes for the custom fields you wish to export. Double click on the Custom Field Merge Codes grid to the right of the custom field name to enter in a merge code.

If you leave the merge code for a field blank, it will not be exported.

Once you enter the merge codes click Next. The wizard moves to the Export tab.

**Step 5: Job Export Schedule**

Set up either a daily, weekly, or monthly import schedule using the controls at the top of the tab. Enter a Print Audit PIN code that has Print Audit Administration privileges. Finally select the directory that contains the directory to export to.

Every time the schedule executes Print Audit exports the jobs to the directory you specify. The new job file name corresponds to the date and time Print Audit exported the data.

When you are satisfied with your schedule, click the Finish button. At this time Print Audit confirms your PIN code and saves the schedule. If your PIN code is incorrect, you will be prompted to change it.
Welcome

Welcome to the Print Audit 5 Database Maintenance Tool. This tool allows you to perform routine maintenance on your Print Audit database. It leads you through each task in an easy to use wizard style interface so you can quickly perform each task, even if you know nothing about databases.

The tool presents you with different options depending on whether you are using a Microsoft Access or Microsoft SQL Server database as a back-end. You chose which one you wanted to use when you installed Print Audit. The tool automatically detects which version you installed and displays the appropriate screens.

Thank you for using Print Audit.

Access Maintenance

Microsoft Access Overview

Microsoft Access is Print Audit 4’s default database. Print Audit uses a database to store all configuration and print job information.
We highly recommend that you use this tool on a scheduled basis to compact your database. Regularly scheduled compacting of the database greatly reduces the risk of database corruption and other issues. It also decreases the size of your database and speeds up database operations.

**Compacting Your Database**

**Compacting your Print Audit Database**

Compacting your Print Audit database is critical to long-term trouble free operation of Print Audit. Print Audit uses Microsoft Access as its database by default. The benefits of using a Microsoft Access database are that it is free, easy to backup and easy to install. The downside is that it requires periodic maintenance to ensure trouble free operation. You perform this periodic maintenance through compacting.

Compacting does several technical things to your database, but the most important thing from your perspective is that it reduces the size of the database, increases the speed of data access and reduces the chance of database corruption.

Print Audit provides two methods of compacting the database. The first is to use the wizard screens to go through and compact. The second is to compact the database from a DOS command-line. The second method allows you to create a batch file that you can then schedule to automatically compact the database periodically.

**To compact the database using the wizard:**

1. Start the Print Audit Database Maintenance tool. The tool starts on the Select Database Task screen.
2. Click the **Compact your Database** option.
3. Click the **Next** button. The wizard moves to the Select your Print Audit Database screen.
4. Enter the Print Audit database you want to compact. The wizard detects what the current database is on this computer. If you want to pick a different database, either type the full path to the database in or select it using the browse button.
5. Click the **Next** button. The wizard moves to the Ready to Compact screen and gives you a chance to go back and change things before you compact.
6. Click the **Next** button. The wizard starts to compact your database. When finished, it moves to the Finished screen and you are done.
To compact the database from the command line:

1. Ensure that no one is running the Print Audit Administration or Viewer programs. These “lock” the database. If locked you cannot compact. The Print Audit Client only locks the database if writing a print job so you should not need to shutdown every client.
2. Start an MS-DOS session.
3. Type the full path to the database maintenance tool, followed by a space, /c, another space and the full path to the database you want to compact. If you do not include the path to the database then Print Audit compacts the currently setup database.
4. Press the Enter key. Print Audit compacts the database.

For example, if you could type the following (X corresponds to the drive where you placed the database):
c:\program files\print audit inc\print audit 5\admin\pa5dbmnt.exe /c X:\printaudit.mdb

You can use this method of compacting within a batch file that you can schedule to run periodically from any number of scheduling tools.

Select the Database Task

This part of the wizard allows you to select which task you want to perform on your Print Audit database. The options are as follows:

- **Compact your database** – Click this option to compact your Print Audit database. Compacting your database reduces size, increases speed and reduces the risk of corruption. Also choose this option if your database has become corrupted and Print Audit will attempt to repair it.

- **Change the read-only password** – Click this option to change the password for the PAReadOnly account. Every Print Audit database has this account with a default password of “password”. If you are concerned about security you should change this password.

Select your Print Audit Database

This part of the wizard allows you to select the Print Audit database on which you want to perform the task you selected. Print Audit automatically chooses the Print Audit database set on this computer. If Print Audit could not find a database, the box is blank.

This screen displays the following information:
Database – Use this box to type in the path to the database on which you want to perform the task. You can also click the Open button to the right of the box to bring up a standard Windows browse dialog so you can search for the database you want.

Click the Next button when you are done to move on to the next screen.

Ready to Compact

This part of the wizard allows you to start compacting your database. If you are not sure you want to compact the database you selected on the previous screen, click Back to select a different one.

As you compact, the status of the operation displays in the rectangular box.

Click the Compact button when you are ready to start the compacting process.

Changing the Read-Only Password

Changing the Read-Only Database Password

For your convenience Print Audit provides a read-only login into your Print Audit database so you can use third party programs to access your data. For example you may need to take the print job data and bring it in to another database in your organization for proper accounting.

Print Audit gives you this functionality through a Microsoft Access database account called “PAReadOnly”. When you install a new Print Audit database the password for this account is “password”. We highly recommend you change this password if you have any concerns about someone using tools other than Print Audit to view your data.

To change the read-only password:

1. Start the Print Audit Database Maintenance tool. The tool starts on the Select Database Task screen.
2. Click the Change the read-only password option.
3. Click the Next button. The wizard moves to the Select your Print Audit Database screen.
4. Enter the Print Audit database you want to change. The wizard detects what the current database is on this computer. If you want to pick a different database, either type the full path to the database in or select it using the browse button.
5. Click the **Next** button. The wizard moves to the **Change your Print Audit Read-Only Password** screen.

6. Type in your old password, new password and new password again to confirm. Please note that if this is the first time you are changing the password, the value you should enter in the **Old Password** box is “password”.

7. Click the **Change** button. Print Audit changes the password and moves to the **Finish** screen. Please store the new password in a safe place. If you lose it there is no way to recover it.

**Select the Database Task**

This part of the wizard allows you to select which task you want to perform on your Print Audit database. The options are as follows:

- **Compact your database** – Click this option to compact your Print Audit database. Compacting your database reduces size, increases speed and reduces the risk of corruption. Also choose this option if your database has become corrupted and Print Audit will attempt to repair it.

- **Change the read-only password** – Click this option to change the password for the PAReadOnly account. Every Print Audit database has this account with a default password of “password”. If you are concerned about security you should change this password.

**Change your Print Audit Read-Only Password**

This part of the wizard allows you to enter your old and new Print Audit read-only passwords. Please remember to store the new password you enter in a safe place. If you lose the new password you will not be able to access the PAReadOnly account for your database.

This screen displays the following information:

- **Old password** – Please enter your existing read-only account password here. If you have never changed the password before, the password is “password”.

- **New password** – Please enter your new password in this box. Do not forget this password.

- **Confirm password** – Please re-enter the password you put in the New password box here. This is just to ensure you entered the password you want.

Click the **Change** button to change the password.
SQL Server Maintenance

Select the SQL Server Task

This part of the wizard requires you to choose which task you want to perform. You can select from the following options:

- **Create a new database** – Click on this option if you want to create a new Print Audit database. This is the first thing you need to do if you do not have an existing Print Audit database.
- **Change the Print Audit user password** – Click this option if you want to change the Print Audit SQL Server login password. This is the password Print Audit users use to login to the database.
- **Change the system administrator (sa) password** – Click this option if you want to change the “sa” login password. This login and password provide access to the entire server and allows you to create databases, etc. We highly recommend you do not leave this password as the default blank password as anyone who knows about SQL Server could then get unrestricted access to your database. The **Create a new database option** gives you the opportunity to change the password at the end of the task.
- **Run a sql script file** – Click this option if you need to run a text file based sql script against the Print Audit database. You should only use this option if someone at Print Audit has directed you to, or if you are an advanced SQL user. Print Audit assumes no responsibility for any data loss or damage caused by someone incorrectly running a script.

Click the **Next** button when you are ready to move on to the next step of the wizard.

Microsoft SQL Server Overview

Print Audit 4 fully supports Microsoft SQL Server as a back-end database. Print Audit uses this database to store configuration information as well as print job information.

This SQL Maintenance tool provides you with simple SQL Server maintenance functionality.
Creating a New Database

Creating a Print Audit Database

The main reason to use the Print Audit Database Maintenance tool is to create a new Print Audit database on the SQL Server. The wizard leads you through the steps to creating the database. If you need specific information about each of the wizard screens, click the Help button at the bottom left of every wizard screen. Below is a general description of how to use the wizard to create a new Print Audit database.

To create a Print Audit database:
1. Start the Print Audit SQL Server Maintenance tool. The wizard starts on the Enter SQL Server Login Information screen.
2. Enter the old SQL Server administration login password and click the Next button. The Select the SQL Server Task screen appears.
3. Click the Create a new database option.
4. Click the Next button. The Enter the Print Audit Database screen appears.
5. Enter the name of the new Print Audit database name in the text box or you can just use the default.
6. Click the Next button. If the Print Audit SQL Server login already exists the Ready to Create screen appears, otherwise the Enter the Print Audit Login Password screen appears. If the Ready to Create screen appears, skip to step 9.
7. Enter the new the Print Audit login password.
8. Click the Next button. The Ready to Create screen appears.
9. Review the information on the Ready to Create screen.
10. Click the Create button to start creating the new Print Audit database. The SQL Maintenance tool starts to create the database. This can take a couple of minutes.
11. If Print Audit detects that it is necessary to change the SQL administrator (sa) password, the Changing the System Administrator Login Password screen appears. Otherwise you are done.

Enter SQL Server Login Information

This part of the wizard requires you to enter your SQL Server login information. Print Audit uses this information to connect to the SQL Server so it can perform operations on the Print Audit database.

This login must have the appropriate permissions to create and modify databases and logins.
The wizard screen contains the following fields:

- **Server** – Please type the name of the SQL server to which you want to connect. This field defaults to “(local)” which means the SQL Server installed on the computer you are using. If you know the name of another server that you want to install the Print Audit database on, please enter that information here.

- **Login** – Please enter the login name for a SQL Server login that has system administrator privileges. This is typically the “sa” account.

- **Password** – Please enter the password for the SQL Server login you specified above.

- **Use Windows authentication** – Check this box if your SQL Server is setup to allow Windows authentication only. This option disables the Login and Password boxes and uses your Windows login and password to attempt connection to the database.

- **Network Provider** – You may need to enter an alternative SQL Server network library dll name in this box if you have troubles connecting to the SQL database. If blank, it uses the default network library as defined on the system. The name you enter here must be the name of the dll minus the extension and the path to the dll. So for example if you want to force Print Audit to use SQL Server’s TCP/IP connectivity, you would enter DBMSSOCN or DBNETLIB. NOTE: This is for advanced SQL Server installations only.

Click the **Next** button when you are ready to move to the next step. If Print Audit cannot find the server or the login and passwords are incorrect an error message will display. You must enter the proper information before you can continue.

**Enter the Print Audit Database Name**

Use this part of the wizard to enter the name for the Print Audit database. You can name this anything you want or just accept the default.

If a database with the same name already exists on the server the wizard warns you and allows you to choose if you want to overwrite it. If you decide you want to overwrite it all of the old information will be lost.

Please remember the name you enter here, as you may need to enter it into Print Audit when you connect to the database for the first time.

The wizard screen contains the following fields:

- **Database** – Enter the name of the new Print Audit database here. You can also leave the default.
Click the **Next** button to move to the next step of the wizard.

**Enter the Print Audit Login Password**

This part of the wizard asks you to enter the Print Audit login password. By default the Database Maintenance tool creates a login account called “PrintAudit” on the SQL Server. This is the account that the other products in the Print Audit suite use to connect to your database.

**NOTE:** You only get this wizard screen while creating a database if the PrintAudit login account does not already exist on the server.

The fields on this screen are:
- **Name** – This field displays the login name for the Print Audit login account. You cannot change this value.
- **Password** – This field allows you to enter a password for the Print Audit login account. All Print Audit applications will use this password to connect to your database. You may want to keep this password private if you are worried about users going into the database using means other than Print Audit.

Click the **Next** button to move on to the next part of the installation.

**Ready to Create**

This part of the wizard provides you with a checkpoint to confirm all of the information you have entered so far. You should write this information down somewhere, as you may need it later to connect to the Print Audit database. If the information on this screen is not correct, you must go back to the previous wizard screens to change it.

This screen displays the following information:
- **Server** – This is the server name that the wizard is going to create the new database on. You entered this server name on the first screen of the wizard. A value of “(local)” means that the wizard will create the database on the SQL server installed on this computer.
- **Database** – This is the name of the database the wizard will create. If “(Overwrite)” is appended to the database name it means that the wizard will replace any existing database with the same name.
- **Login** – This is the name of the Print Audit database login account. This login name cannot be changed. Print Audit will use this login name to connect to the database.
• **Password** – This is the password for the Print Audit login account. A value of “<Password previously set>” for the password means that the Print Audit login account already exists on the SQL Server and will not be changed.

Click the **Create** button to have the Print Audit wizard create the database. Click the **Back** button to go back in the wizard and change any information that is incorrect.

### Change the System Administrator Password

This part of the wizard allows you to change the SQL Server “sa” login password. The “sa” account is the main SQL Server account. If you leave it open and unsecured anyone with SQL tools can access and change your server.

**NOTE:** You only get to this screen while creating a new database if the initial login account was “sa” and the password was blank.

The fields on this screen are:

- **New password** – Enter the new password for the “sa” login. Please record this password somewhere. If you forget the password you will have to reinstall the SQL Server.

Click the **Change** button to change the password.

### Finished Using the Wizard

This part of the wizard displays a summary of the task you just accomplished. Congratulations!

Click the **Done** button to exit the wizard.

### Changing the Print Audit Login Password

You can use the Print Audit Database Maintenance tool to change the Print Audit login password. This is the password that all Print Audit users use to connect to the database.

**To change the Print Audit login password:**

1. Start the Print Audit Database Maintenance tool. The wizard starts on the **Enter SQL Server Login Information** screen.
2. Enter the SQL Server administration login password and click the **Next** button. The *Select the SQL Server Task* screen appears.
3. Click the *Change the Print Audit User Password* option.
4. Click the **Next** button. The *Change the Print Audit User Password* screen appears.
5. Enter the new password for the Print Audit user login.
6. Click the *Change* button to change the password.

**Enter SQL Server Login Information**

This part of the wizard requires you to enter your SQL Server login information. Print Audit uses this information to connect to the SQL Server so it can perform operations on the Print Audit database.

This login must have the appropriate permissions to create and modify databases and logins.

The wizard screen contains the following fields:

- **Server** – Please type the name of the SQL server to which you want to connect. This field defaults to "(local)" which means the SQL Server installed on the computer you are using. If you know the name of another server that you want to install the Print Audit database on, please enter that information here.
- **Login** – Please enter the login name for a SQL Server login that has system administrator privileges. This is typically the "sa" account.
- **Password** – Please enter the password for the SQL Server login you specified above.
- **Use Windows authentication** – Check this box if your SQL Server is setup to allow Windows authentication only. This option disables the Login and Password boxes and uses your Windows login and password to attempt connection to the database.
- **Network Provider** – You may need to enter an alternative SQL Server network library dll name in this box if you have troubles connecting to the SQL database. If blank, it uses the default network library as defined on the system. The name you enter here must be the name of the dll minus the extension and the path to the dll. So for example if you want to force Print Audit to use SQL Server’s TCP/IP connectivity, you would enter DBMSSOCN or DBNETLIB. **NOTE:** This is for advanced SQL Server installations only.

Click the **Next** button when you are ready to move to the next step. If Print Audit cannot find the server or the login and passwords are incorrect an error message will display. You must enter the proper information before you can continue.
Change the Print Audit User Password

This part of the wizard allows you to change the Print Audit login password. This is the account that the other products in the Print Audit suite use to connect to your database. You only need to change the password if you have forgotten the old one or if you are concerned about security.

The fields on this screen are:

- **Name** – This field displays the login name for the Print Audit login account. You cannot change this value.
- **New password** – Enter the new password for the Print Audit login account here. Please note that everyone using Print Audit tools will now have to use this new password to get into your database.

Click the **Change** button to change the password.

Finished Using the Wizard

This part of the wizard displays a summary of the task you just accomplished. Congratulations!

Click the **Done** button to exit the wizard.

Changing the System Administrator Password

Changing the System Administrator Login Password

You can use the Print Audit Database Maintenance tool to change the system administrator login password. This is the password for the SQL Server “sa” account. This is a special account in SQL Server that has full power to change anything on a SQL Server. This password is blank by default when you install SQL Server, so you want to change it as soon as possible.

**To change the system administrator login password:**

1. Start the Print Audit Database Maintenance tool. The wizard starts on the **Enter SQL Server Login Information** screen.
2. Enter the old SQL Server administration login password and click the **Next** button. The **Select the SQL Server Task** screen appears.
3. Click the **Change the system administrator (sa) password** option.
4. Click the **Next** button. The **Change the System Administrator Password** screen appears.
5. Enter the new password for the system administrator.
6. Click the **Change** button to change the password.

**NOTE:** The wizard also allows you to change the system administrator password at the end of the Create Database process.

### Enter SQL Server Login Information

This part of the wizard requires you to enter your SQL Server login information. Print Audit uses this information to connect to the SQL Server so it can perform operations on the Print Audit database.

This login must have the appropriate permissions to create and modify databases and logins.

The wizard screen contains the following fields:

- **Server** – Please type the name of the SQL server to which you want to connect. This field defaults to “(local)” which means the SQL Server installed on the computer you are using. If you know the name of another server that you want to install the Print Audit database on, please enter that information here.
- **Login** – Please enter the login name for a SQL Server login that has system administrator privileges. This is typically the “sa” account.
- **Password** – Please enter the password for the SQL Server login you specified above.
- **Use Windows authentication** – Check this box if your SQL Server is setup to allow Windows authentication only. This option disables the **Login** and **Password** boxes and uses your Windows login and password to attempt connection to the database.
- **Network Provider** – You may need to enter an alternative SQL Server network library dll name in this box if you have troubles connecting to the SQL database. If blank, it uses the default network library as defined on the system. The name you enter here must be the name of the dll minus the extension and the path to the dll. So for example if you want to force Print Audit to use SQL Server’s TCP/IP connectivity, you would enter DBMSSOCN or DBNETLIB. **NOTE:** This is for advanced SQL Server installations only.

Click the **Next** button when you are ready to move to the next step. If Print Audit cannot find the server or the login and passwords are incorrect an error message will display. You must enter the proper information before you can continue.
Change the System Administrator Password

This part of the wizard allows you to change the SQL Server “sa” login password. The “sa” account is the main SQL Server account. If you leave it open and unsecured anyone with SQL tools can access and change your server.

NOTE: You only get to this screen while creating a new database if the initial login account was “sa” and the password was blank.

The fields on this screen are:
- **New password** – Enter the new password for the “sa” login. Please record this password somewhere. If you forget the password you will have to reinstall the SQL Server.

Click the **Change** button to change the password.

Finished Using the Wizard

This part of the wizard displays a summary of the task you just accomplished. Congratulations!

Click the **Done** button to exit the wizard.

Running a SQL Script

You can use the Print Audit Database Maintenance tool to run any sql script against the Print Audit database. You may need to run scripts to repair accidentally damaged databases, or to perform different database maintenance tasks.

NOTE: Print Audit is not responsible for any damage or loss of data that occurs when running scripts against your database that you have not received directly from Print Audit. You should only use this functionality if Print Audit directs you to, or if you are an advanced SQL user.

**To run a sql script:**

1. Start the Print Audit Database Maintenance tool. The wizard starts on the **Enter SQL Server Login Information** screen.
2. Enter the SQL Server administration login password and click the **Next** button. The **Select the SQL Server Task** screen appears.

3. Click the **Run a sql script file** option.

4. Click the **Next** button. The **Enter the Print Audit Database Name** screen appears.

5. Enter the name of the Print Audit database you want to run the script against.

6. Click the **Next** button. The **Select a SQL Script File** screen appears.

7. Type the path to the script file, or click the **Browse** button to open a standard dialog so you can look for the file.

8. Click the **Run** button to run the script. After the script has completed the **Summary** screen appears.

### Enter SQL Server Login Information

This part of the wizard requires you to enter your SQL Server login information. Print Audit uses this information to connect to the SQL Server so it can perform operations on the Print Audit database.

This login must have the appropriate permissions to create and modify databases and logins.

The wizard screen contains the following fields:

- **Server** – Please type the name of the SQL server to which you want to connect. This field defaults to “(local)” which means the SQL Server installed on the computer you are using. If you know the name of another server that you want to install the Print Audit database on, please enter that information here.

- **Login** – Please enter the login name for a SQL Server login that has system administrator privileges. This is typically the “sa” account.

- **Password** – Please enter the password for the SQL Server login you specified above.

- **Use Windows authentication** – Check this box if your SQL Server is setup to allow Windows authentication only. This option disables the **Login** and **Password** boxes and uses your Windows login and password to attempt connection to the database.

- **Network Provider** – You may need to enter an alternative SQL Server network library dll name in this box if you have troubles connecting to the SQL database. If blank, it uses the default network library as defined on the system. The name you enter here must be the name of the dll minus the extension and the path to the dll. So for example if you want to force Print Audit to use SQL Server’s TCP/IP connectivity, you would enter DBMSSOCN or DBNETLIB. NOTE: This is for advanced SQL Server installations only.
Click the **Next** button when you are ready to move to the next step. If Print Audit cannot find the server or the login and passwords are incorrect an error message will display. You must enter the proper information before you can continue.

**Enter the Print Audit Database Name**

Use this part of the wizard to enter the name of the Print Audit database you want to run the script against. If the database does not exist, Print Audit does not allow you to continue. The wizard screen contains the following fields:

- **Database** – Enter the name of the Print Audit database here.

Click the **Next** button to move to the next step of the wizard.

**Select a SQL Script File**

This part of the wizard allows you to select the SQL script file you want to run against the database. Please note that Print Audit is not responsible for any loss of or damage to your Print Audit data when running a script not approved by Print Audit. You should not use this functionality unless Print Audit instructs you to or unless you are an advanced SQL user. This screen displays the following information:

- **Script** – Type the full path and name of the sql script file you want to run here. You can also click the Browse button to open a standard Windows dialog so you can find the file you want to run.

Click the **Run** button to run the script.

**Print Audit 5 Client Status and Deployment Tool**

**Welcome**

Welcome to the Print Audit Client Status/Deployment tool. This tool has three main uses:

- Query computers on a network and retrieve information about Print Audit 5 client installations.
- Install or upgrade the Print Audit 5 Client on a collection of computers on the network.
- Uninstall the Print Audit 5 Client from a collection of computers on the network.
This tool is not recommended for use with computers running Windows 95, Windows 98, or Windows ME. The minimum requirement is Windows NT 4.0; Windows 2000 or newer is recommended.

Usage Requirements

Minimum Requirements

You must have the Active Directory client extensions installed on a computer to use the Client Status/Deployment tool. The extensions are included with Windows 2000, Windows XP and Windows 2003 operating systems. Print Audit installs the Active Directory extensions on Windows NT4.0 computers.

Note that only the computer running the Client Status/Deployment tool needs the Active Directory extensions. Status information and installs can run on computers without the Active Directory extensions.

You can get the Active Directory extensions for Windows 95, 98 and ME from Microsoft. However we do not recommend this as Microsoft does not support it.

Requirements for gathering status information from a network

There are no additional software requirements for using the Client Status / Deployment Tool to gather information about Print Audit 5 client installations on the network.

Permissions

To effectively gather status information, you must have the appropriate permissions on the network. The required permissions depend on your network configuration. In general, you need enough permissions to browse computers on the network.

Requirements for pushing the Print Audit 5 client installation to computers on a network

The Client Status / Deployment Tool can only push client installations to (or remotely uninstall the Print Audit 5 client from) computers running Windows NT 4, Windows 2000, Windows XP, or Windows 2003 operating systems.
Permissions

In order to **install**, **upgrade**, or **uninstall** Print Audit 5 on network computers, you must have Administrator privileges on the computers you want to install on, upgrade, or uninstall from. For networks using Active Directory or NT Domains we recommend that you have Domain Admin privileges.

Using the Tool

Querying Client Status

You can use the Client Status / Deployment Tool to query a network and return information about Print Audit 5 installations.

To query a domain:

1. Select **Domain / Open** from the menu, or click the left-most button in the toolbar. The Open Domain dialog appears.
2. Enter in the name of the domain or workgroup you want to query.
3. Click the OK button. A progress dialog appears while Print Audit gathers information.

When you query the network Print Audit returns the computer name and operating system. If the Print Audit Client is installed on a computer the following information also displays:

1. The version of the Print Audit Client
2. The current Print Audit user (if any)
3. The last time that computer printed
4. The first time the Print Audit client was ever seen running by the push install / status tool
5. The most recent time the Print Audit client was seen running

If no information about the Print Audit Client is shown for a computer it is usually caused by one of the following three conditions:

- The Print Audit 5 client is not installed on that computer
- The Print Audit 5 client is installed, but is not currently running (possibly because nobody is logged into that computer)
- An older version of the Print Audit client is installed (for instance, Print Audit 4)
You may save the current status by clicking Domain / Save Report in the menu, or clicking the second button from the left in the toolbar.

**Installing Print Audit 5 to Network Computers**

You can use the Client Status / Deployment Tool to push the installation or an upgrade of the Print Audit 5 Client to other computers on the network. Whether you are installing or upgrading, the process is the same.

**To install Print Audit 5 to the network:**
1. Query the network client status.
2. Select the computers on which you want to install or upgrade the Print Audit 5 Client. You can use SHIFT-CLICK and CTRL-CLICK to select more than one computer.
3. Click the **Push->Install to Selected Computers** menu item. The **Select Package to Install** dialog appears.
4. Select or create an installation package.
5. Click the **Install** button. A progress dialog appears showing the installation to the computers.

**IMPORTANT:** You cannot use this tool to install the Client to Windows 95, 98 or ME computers. If you want to deploy the Print Audit Client to these operating systems you must use another method such as login scripts.

**Removing Print Audit 5 from Network Computers**

You can use the Client Status / Deployment Tool to uninstall the Print Audit 5 Client from other computers on the network. This is a very similar process to installing or upgrading the client on network computers.

Note that you **cannot** use this tool to uninstall older versions of Print Audit (for example, Print Audit 4) from network computers.

**To uninstall Print Audit 5 from network computers:**
1. Query the network client status.
2. Select the computers from which you want to uninstall the Print Audit 5 Client. You can use SHIFT-CLICK and CTRL-CLICK to select more than one computer.
3. Click the **Push->Uninstall from Selected Computers** menu item. The **Select Package to Install** dialog appears.
4. Select the package you want to uninstall.
5. Click the **Uninstall** button. A progress dialog appears showing the installation to the computers.

**Working With Installation Packages**

**Selecting a Package**

Click on the package name on the **Select Package** dialog. You need to select a package when installing, upgrading, or uninstalling the Print Audit 5 client on network computers.

**Importing a Package**

If you used the Print Audit 5 installer to create a network installation you can import this network installation as a package and use it with this tool to install, upgrade, or uninstall the Print Audit 5 client.

Click the **Import...** button, and browse for the package.ini file for the network installation. This is usually in the same directory as the network installer package that you created using the Print Audit 5 installer.

Once you locate the package.ini file, click Open to import the package. You can immediately select this package and use it.

**Creating a Package**

Generally, you will want to import packages as described above. In some cases, though, you may want to create a new package yourself. To create a new package, click the Add button in the Select Package dialog. The Create New Install Package window will appear. Fill in the settings as described below:

1. **Name** - the name you want to use for this install package.
2. **Description** - a description you want to use for this install package.
3. **Installer** - the Setup (.exe) or Windows Installer (.msi) file you want to push to the clients.
4. **Notify Users when Installation Completes** - Check this box to have a dialog box appear on the computer after the installation finishes. This dialog informs the user that the package successfully installed.
5. **Command Line Parameters** - If the installer requires command line parameters, provide these here. MSI packages automatically get the appropriate command-line parameters for silent installation.
When you are satisfied with the settings, click the OK button to create the installation package. You can immediately select and use this newly-created installation package.

**Editing a Package**

To edit an existing package, double-click on its name in the list of packages. You can change any of the settings you want. Click OK when you have finished, or Cancel if you do not want to save your changes. For a description of all the fields, see the description for Creating a Package (above).

**Deleting a Package**

To delete a previously created installation package select it from the list in the Select Package dialog and click the Delete button.

**Print Audit 5 Copy Audit**

Welcome to the Print Audit Copy Audit system. This software and hardware combination allow you to track walk up copying to your copiers and report it to the standard Print Audit database. Copy Audit consists of three main components:
• **Copy Audit Administration.** This is a plug-in for the standard Print Audit 5 Administration tool which allows you to configure the Copy Audit Hardware Devices.

• **Copy Audit Communicator.** This program handles all of the communication between the Copy Audit boxes and the Print Audit database.

• **Copy Audit Hardware.** The Copy Audit hardware is one or more devices that connect to your network and to your copier. These devices "talk" to the Communicator to validate user entry and store the number of copies made to the Print Audit database. You must have one Copy Audit device for every copier to which you want to track walk up copying.

Once the Copy Audit devices are configured, Print Audit stores information for your copy jobs in the standard Print Audit database. You can then use the Print Audit Job Manager and Analysis Reporting tools to view and report on the data. For more information on these reporting tools, please view their respective help files.

**Copy Audit Communicator**

The Copy Audit Communicator handles all communication between the Copy Audit hardware devices and the Print Audit database. One Copy Audit Communicator can handle multiple Copy Audit hardware devices. It runs on any Windows based operating system, but we highly recommend installing it on a Windows NT based computer (Windows NT 4, Windows 2000, Windows XP or Windows Server 2003).

The computer running the Copy Audit Communicator must be turned on for copy jobs to get to the Print Audit database.

**Technical Notes**

• The Copy Audit Communicator runs as a service on NT-based operating systems or as a regular program on Win9x operating systems.

• You must be running a TCP/IP network in order to use Print Audit Copy Audit

• The Communicator communicates with the Copy Audit Box hardware devices on TCP/IP port 10001. If anything else on the network relies on port 10001 this could cause conflicts.

• The Communicator writes any errors to an error log file called "PA5CopyAuditCommunicator.log". Print Audit creates this file in a sub-directory of the Application Data directory on your computer. For Windows 2000/XP computers the directory is "C:\Documents and Settings\All Users\Application Data\Print Audit Inc\Print Audit\5.0\Logs".
Administration

Copy Audit Device Edit Window

You use this window to add new and edit existing Copy Audit hardware configurations.

General

The main part of the edit window contains three mandatory fields:

- **Name** - This is the name you want to give this Copy Audit Device. This name shows up in the Print Audit database for tracked copy jobs.
- **MAC Address** - The MAC address of the Copy Audit Device. This is printed on a sticker on the bottom of the device.
- **IP Address** - The IP address of the Copy Audit Device. When you first configure the device, you must provide a valid IP address. If you do not know what IP address is valid on your network, please ask your internal network support.

The rest of the Copy Audit Device Edit Window is divided into five tabs, each with several configuration settings.

Prompts Tab

Use this tab to configure what information Copy Audit asks for before you can make copies, or do other transactions such as postage costs. Please note that the PIN codes/values you enter for the prompts must be numeric only. You can configure up to five prompts, but you must configure at least one.

**To configure a prompt:**

1. Click on the **Type** column and select the type of prompt from the drop-down list. The prompt text appears on the right.
2. If you selected **Unvalidated** as the prompt type, double-click on the **Prompt** column and enter the prompt that you want.
3. Continue steps 1-2 until you have configured the prompts that you want.

Function Keys Tab

Use this tab to configure how the function keys on the Copy Audit hardware work. You can use the function keys to have Copy Audit record different types of expenses such as postage, fax copies, etc.
• **Enable function keys** – If checked the function keys on the Copy Audit box are active. The user can use these keys to enter business costs other than making copies.

• **Use F3 as Misc/External Copies** – Use this to set if you want to use the F3 key on the Copy Audit box to enter miscellaneous business costs, or to enter information about copies made externally to your company.

• **Use F2 as Courier/Scan** – Use this to set if you want to use the F2 key on the Copy Audit box to enter courier costs, or to set the Copy Audit box to “scanning” mode.

### Costs Tab

Use this tab to enter the costs charged for copies and other transactions. You also use this tab to define the paper size that Print Audit reports for copy jobs.

- **Copy cost** - The cost per copy used when making regular copies.
- **External copy cost** - The cost per copy used when using the F3 key, and the setting is set to **External Copies**.
- **Fax cost** - The cost per fax page used when using the F4 function key to enter in fax pages.

To define the paper size for the copy transactions:

- **Description** - The description of the paper size. You can use this drop-down to select from a standard paper size or type in a custom name.
- **Units** - The unit size of the paper. Use the drop-down to select the appropriate unit type.
- **Width** - The width of the paper size, in the units you selected.
- **Height** - The height of the paper size, in the units you selected.

### Timeouts Tab

Use this tab to modify the timeout settings for the Copy Audit Device. Timeouts control how long the Copy Audit waits for information before it cancels. In general, the defaults should work fine but you can change them if you need to shorten or lengthen the timeouts.

- **Server response** – This is how long the Copy Audit box will wait to get a response from the Communicator. Once the timeout is up the Copy Audit box continues to the next prompt or action.
- **Field Inactivity** – This is how long the Copy Audit box will wait for a user to enter something at a prompt. If nothing entered within this time limit the Copy Audit box returns to displaying the date and time.
- **Walkaway** – This is how long the Copy Audit box will wait for the user to make copies before it returns to displaying the date and time.
• **Hold timeout** – This is how long a user can extend the Walkaway timeout. It is a multiple of the Walkaway timeout. Only used if you place Copy Audit in "hold mode".
• **Scan timeout** – This indicates how long the Copy Audit box will remain in “Scan mode” until it resets to the time/date prompt. Only used if the F2 key is set to “Scan”.

### Advanced Tab

Use this tab to configure some advanced functionality of the Copy Audit hardware. Please note that we recommend you do not change these settings unless absolutely necessary.

- **Delimiter key** – This is the character to use when a user presses the “-” key on the Copy Audit box.
- **Unit password** – This is the password required to enter into the “Service Mode” on the box. Defaults to 1234.
- **Simulated copy mode** – If checked a person using the Copy Audit box can press the “White” button on the Copy Audit box to increase the copy count while in a transaction. You should have this checked only for testing purposes.
- **Disallow copying** - If checked the Copy Audit box does not allow copies if it cannot connect to the Copy Audit Communicator. NOTE: This setting is not supported on older Copy Audit hardware.

### Prompt Types

You can configure up to five prompts. Copy Audit uses these prompts to get information from the user before they start making copies. You must configure at least one prompt type.

The types are as follows:

- **PIN Codes** - This corresponds to the user PIN code you can setup in the Administration tool. You use the PIN code to uniquely identify the user making the copies. To setup PIN codes for users please see the Print Audit Administration tool help.
- **Validated values** - This corresponds to Custom Field values you can setup in the Administration tool. You must first configure a Custom Field with the appropriate values, using the Client Custom Fields section of the Print Audit Administrator. Then, you will be able to select the Custom Field as a prompt on this screen. See the Print Audit Administrator for more information on configuring Client Custom Fields.
- **Unvalidated values** - This corresponds to the Comments field. This allows the user to enter any value they want. Print Audit stores this
information as entered with the copy job. You can use this for free-form entries, such as tracking fax numbers.

Please note that for PIN Codes and Validated Values you must use numeric-only entry values.

Overview

The Copy Audit Administration plug-in allows for configuration of all aspects of Print Audit copy tracking.

You can use the administration plug-in to do the following:

1. Add, edit and delete Copy Audit hardware configurations.
2. View and change the status of Copy Audit hardware devices.
3. Start and stop the Copy Audit Communicator.

Copy Audit uses the same Custom Fields and user PIN codes as the rest of Print Audit. Please see the sections in the Administration help that cover those topics for more information.

Adding, Editing and Deleting Copy Audit Configurations

You use the Copy Audit section of the Administration tool to add, edit and delete Copy Audit configurations. You must set up one Copy Audit configuration for each Copy Audit hardware device you have.

To add a new Copy Audit Configuration:

1. Make sure you connect the Copy Audit hardware device to the network.
2. Click the Copy Audit button on the left hand side of the Print Audit Administration window. The list of existing Copy Audit configurations appears on the right side. You may have to scroll the left hand side down before you see the Copy Audit button.
3. Click the New button on the toolbar. The Copy Audit Device Edit Window appears.
4. Enter in the information as appropriate. Note that you must enter the Name, IP address and MAC address for the hardware device. You can find the MAC address of the device on a sticker on the bottom of the Copy Audit hardware.
5. Click the Add button. Print Audit starts to configure the Copy Audit hardware. Once configured the Copy Audit Edit window closes and you see your new device in the list. Please note that it can take up to 30 seconds to configure your device.
The Copy Audit device does not start tracking unless the status of the device in the list is "Connected". If the status is not connected, make sure the device is online and the Copy Audit Communicator is running.

**To edit a Copy Audit Configuration:**

1. Click the Copy Audit button on the left hand side of the Print Audit Administration window. The list of existing Copy Audit configurations appears on the right side. You may have to scroll the left hand side down before you see the Copy Audit button.
2. Double-click on the device you want to edit in the list of configurations on the right hand side. The **Copy Audit Device Edit Window** appears.
3. Make the required configuration changes.
4. Click the **Save** button. Print Audit re-configures the Copy Audit hardware and the window closes. Please note that this can take up to 30 seconds.

**To delete a Copy Audit Configuration:**

1. Click the Copy Audit button on the left hand side of the Print Audit Administration window. The list of existing Copy Audit configurations appears on the right side. You may have to scroll the left hand side down before you see the Copy Audit button.
2. Click on the device in the list of configurations. The device highlights.
3. Click the **Delete** button in the toolbar at the top of the Administration window. A message appears asking you to confirm you want to delete the configuration.
4. Click the **Yes** button. Print Audit removes the Copy Audit configuration from the list and the Copy Audit hardware no longer tracks jobs.

**Viewing and Changing Copy Audit Status**

You can view the status of your configured Copy Audit hardware in the list of devices, and take them offline.

**To view the status:**

1. Click the Copy Audit button on the left hand side of the Print Audit Administration window. The list of existing Copy Audit configurations appears on the right side. You may have to scroll the left hand side down before you see the Copy Audit button.
2. Look at the right most column, labeled "Status". This column contains the current status of the device.
The statuses are as follows:

- **Offline** - The hardware may be connected properly, but either the Copy Audit Communicator is not running or you have set the hardware to run offline. Any jobs entered at the Copy Audit hardware are stored in internal memory and will be sent to the database the next time the box is brought online.

- **Connected** - The hardware is online and connected. All copy jobs entered at the Copy Audit hardware saves directly to the database.

- **Disconnected** - The hardware is online, the Copy Audit Communicator is running but Print Audit cannot connect to the box. This indicates a bad connection to the box. Common symptoms are the cable connecting the box to the network is unplugged, or the box has lost power.

To change the status:

1. Click the Copy Audit button on the left hand side of the Print Audit Administration window. The list of existing Copy Audit configurations appears on the right side. You may have to scroll the left hand side down before you see the Copy Audit button.
2. Click the **Online** checkbox in the left most column of the list for the device you want to take online/offline. If checked, the box is online, if unchecked the box is offline.

### Starting and Stopping the Copy Audit Communicator

Normally, you will want to have the Copy Audit Communicator running. If you need to stop or restart it for some reason (for instance, to troubleshoot problems), you can do so using the Copy Audit Administration plug-in.

To check the status of the Copy Audit Communicator:

1. Click the Copy Audit button on the left hand side of the Print Audit Administration window. The list of existing Copy Audit configurations appears on the right side. You may have to scroll the left hand side down before you see the Copy Audit button.
2. The status of the Copy Audit Communicator displays just above the list of devices.

To start/stop the Copy Audit Communicator:

1. Click the Copy Audit button on the left hand side of the Print Audit Administration window. The list of existing Copy Audit configurations appears on the right side. You may have to scroll the left hand side down before you see the Copy Audit button.
2. The status of the Copy Audit Communicator displays just above the list of devices, the Start and Stop buttons are to the right.
3. Click the Start button to start the Communicator if it is not running, or click the Stop button to stop the Communicator. The status area updates to show the new status.

Copy Audit Hardware

Using the Copy Audit Hardware

Once you have connected the Copy Audit hardware device to your copier and to the network, and have configure the device with the Administration tool, you are ready to track all of your walk-up copying information. Below is the list of activities you can track with Copy Audit.

Tracking Walk-up Copying

The Copy Audit device connects to your copier and disables copying until the user successfully enters the information you require. To track walk-up copying:

1. Press the Enter key on the Copy Audit keypad. Depending on how you configured the device it may ask for a PIN code or for a code corresponding to a project, client, etc.
2. If prompted, enter in a valid code and press the Enter key. If you enter an invalid code, the Copy Audit device beeps and resets to the time and date. If valid, Copy Audit either presents the next prompt or switches over to wait for you to make copies.
3. Once you have entered all the values as prompted, Copy Audit will switch into copying mode.
4. Once in copying mode simply make copies as usual.
5. When done making copies, press the Cancel key to set the Copy Audit device to wait for the next user. The copy information is saved to the Print Audit database.

"Holding" the Copier

There are some situations after you begin copying where you need more time than the normal "walkaway" timeout would permit to finish your copying. If more time is needed you can put Copy Audit in a "hold state". To do so:

- While copying, press the back arrow key on the Copy Audit device. This puts it in hold mode. Once you start making more copies the hold mode automatically cancels.
Tracking Copying with User Quotas
If you have configured Copy Audit to ask for PIN codes and have also used the Print Audit administrator to configure both Declining Balances and PIN Codes for users, the following will happen:

1. If a user enters a PIN code that has a zero balance the Copy Audit device displays an error message to the user and goes back to the time and date. It will not allow the user to make copies.
2. If a user exceeds their quota while making copies the Copy Audit device automatically stops copying and switches back to the time and date.

Tracking Copying with Custom Field Value Quotas
If you have setup Copy Audit to ask for one or more client custom field values and have also used the Print Audit administrator to configure both Declining Balances for client custom field values, the following will happen:

1. If a user enters a custom field value that has a zero balance the Copy Audit device displays an error message to the user and goes back to the time and date. It will not allow the user to make copies.
2. If a user exceeds the quota for the custom field value while making copies the Copy Audit device automatically stops copying and switches back to the time and date.

Using the Function Keys
If you have enabled the function keys on the Copy Audit device, you can use them to enter other business transactions you want to keep track of into the Print Audit database. Below are the transactions you can enter using the function keys.

- **Entering Postage Information (F1)**
  1. Press the F1 key on the Copy Audit keypad. Copy Audit prompts the user for valid codes. For more information on this process, see the section above called Tracking Walk-up Copying.
  2. Enter valid codes. Copy Audit prompts for the quantity.
  3. Enter the quantity and press the Enter key. The quantity corresponds to the number of pieces mailed. The unit prompts for the cost.
  4. Enter the postage for the mail and press the Enter key. Do not enter a decimal, the Copy Audit device automatically assumes two
decimal places. For example if you enter "37" it gets translated to 0.37.

Print Audit records the final transaction amount as the quantity you entered multiplied by the cost. For example, if you entered a quantity of 10 pieces of mail at 45 cost the total cost would be $4.50.

• **Entering Courier Information (F2 if option set to "Courier")**
  1. Press the F2 key on the Copy Audit keypad. Copy Audit prompts for valid codes. For more information on this process, see the section above called Tracking Walk-up Copying.
  2. Enter valid codes. Copy Audit prompts for "Courier".
  3. Enter the total courier cost and press the Enter key. Do not enter a decimal, the Copy Audit device automatically assumes two decimal places. For example, if you enter "1000" it gets translated to $10.00. Print Audit records the courier transaction and the Copy Audit device goes back to displaying the time and date.

• **Putting the Copy Audit Device in "Scan" mode (F2 if option set to "Scan")** The Copy Audit hardware supports a "Scan" mode. While in this mode the copier is unlocked for scanning and can have a long (30 minute max) timeout. Nothing is tracked in this scan mode, it is simply there to better accommodate multi-function devices with scanning capability.
  1. Press the F2 key on the Copy Audit keypad. Copy Audit prompts for valid codes. For more information on this process, see the section above called Tracking Walk-up Copying.
  2. Enter the valid codes. Copy Audit switches to scan mode.
  3. Complete your scanning and press the Cancel key. The Copy Audit device goes back to displaying the time and date.

• **Entering Miscellaneous Costs (F3 if option set to "Misc")**
  1. Press the F3 key on the Copy Audit keypad. Copy Audit prompts for valid codes. For more information on this process, see the section above called Tracking Walk-up Copying.
  2. Enter the valid codes. Copy Audit prompts for "Misc."
  3. Enter the total miscellaneous costs and press the Enter key. Do not enter a decimal, the Copy Audit device automatically assumes two decimal places. For example, if you enter "1000" it gets translated to $10.00. Print Audit records the transaction and the Copy Audit device goes back to displaying the time and date.
• **Entering External Copies (F3 if option set to "External Copies")**
  1. Press the F3 key on the Copy Audit keypad. Copy Audit prompts for valid codes. For more information on this process, see the section above called Tracking Walk-up Copying.
  2. Enter the valid codes. Copy Audit prompts for "# of copies"
  3. Enter the total number of copies and press the Enter key. Print Audit records the transaction and the Copy Audit device goes back to displaying the time and date.

• **Entering Fax Pages (F4)**
  1. Press the F4 key on the Copy Audit keypad. Copy Audit prompts for valid codes. For more information on this process, see the section above called Tracking Walk-up Copying.
  2. Enter the valid codes. Copy Audit prompts for "# of pages"
  3. Enter the total number of pages and press the Enter key. Print Audit records the transaction and the Copy Audit device goes back to displaying the time and date.

**Copy Audit Hardware Features**

**Dimensions:** 7.5"L x 4"W x 3"H

**Weight:** 12 ounces

**Memory:** Unlimited number of User and Account codes and battery-backed RAM memory for off-line data storage

**Battery:** Lithium power cell – 10 year life

**Display:** 2 line by 16 character LCD display

**Keyboard:** Large full-travel 20 key numeric keyboard. Includes special function keys for entering postage data, fax pages and other miscellaneous entries

**Network Interface:** Ethernet 10/100 Auto-Sensing RJ-45, TCP/IP

**Configurable:** User-definable field prompts, function keys, walk-away and hold timeouts

**Power Requirements:** North America – standard 110V outlet. Europe – requires universal adapter
**Copier Interface:** Optocoupled, key-operated bypass module provides a generic, isolated electrical copier interface